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CIRCULAR

It is to inform all the facutty of Deoartment of Comouter Science to attend staff meeting at

ll:00 pM in the HOD chamber to discuss the conduct of Certificate Courses for the academic year

20r8-r9.

Faculty Members Attended:

Aqenda: Certificate coutses to bc conducted for the Academic Yesr 201&19'

All the staff members ofthe department discussed the agenda. The following resolutions were

passed unanimously.

) lt was decided to conduct a certificate course on UqE!!E to the Second Year students in the

first week of $9p11q!9g month.

)> It was decided to conduct a c€rtificate course on $j@gg to the Second yeal. studenB in the

fint week of lg@gry month.

) HOD offered vote ofthanks.

Frcultv: Signature:

l. Smt B.Triveni

2. Smt N.Jayalakshmi

L Sri D.Chaitanya Kumar

"3:33:ffir:.,,

SignatureName of the FacultyHOD

N
I . Smt B.Triveni

2. Smt N.Jayalakshmi

3. Sri D.Chaitanya Kumar

Sri P.Udaya



It is to inform to all the II Year B.Sc MPCS, MSCS, MPC, MPS students that

we are going to conduct a Certificate Course. The details of the course offered are as

follows.

Students who are interested to join the course can contact the Coordinator of Certificate

Course Sri P.Udaya for further details of course content, study material and prerequisites ofthe

course.

Course Coo

Course name
MS-Office

Course date & duration
17lJmuaryl2019 to I l/Iebruary/2019 : 40 Hours

Timings Batch l:
Theory: 8:00 AM to 9:00 AM
Practical: 4:00 PM to 5:00 PM

Batch 2:
Theory: 5:00 PM to 6:00 PM
Practical: 8:00 AM to 9:00 AM

Course Mentors Batch l: B.Triveni, D.Chaitanya Kumar
Batch 2: N.Jayalakshmi, D.Chaitanya Kumar

DtPARI,:r.

s.c.il
1i:

NOTICE

SGSACA)ept.of Computer Science/HOD/Certificate Course/2018-19



Permission Letter
SGSAC/Deot.of Computer Science/HOD/Certificate Course/201&19

Fronr Date: l4-01-2019.

HOD,

Department of Computer Science,

S.G.S Arts College,

Tirupati.

To

The Principal,

S.G.S Atu College,

Tirupati.

Respected Sir,
Sub: Requesting for permission to conduct Certificate Course in M$OIIice - Regarding'

we have planned to conduct a forty hours certificate course on M$OIfice for two batches of

Second Year students from 17-01-2019 to 11-02-2019. Therefore kindly permit us to conduct this

Certificate Course.

Thanking Yoq Yours Faithfully,

HE D
DfPA[IIITilI 0r co,llPunii

s.G.s. ARTS, {'' rr, : '

TIRU'!,:\i1



Details of the Course

Name of the Certificate Course

Batch

Timing

No. ofstudents/ Dept/Year/ Course Duration:

Venue :

Eligible Groups

Trainers

Certificate

Course Coordinator

MS-Office

I

Theory: 8:00 AM to 9:00 AM

Practical: 4:00 PM to 5:00 PM

60/ Comp.Science/ 2016-17/ 40 Hours

Theory: Room No 215

Practical: Comp.Science Lab

II Year B.Sc MPCS, MSCS, MPC, MPS

B.Triveni, D.Chaithanya Kumar

Yes

Sri P.Udaya

HEAD
DtPARItiItU OI COI,IPIIIER SCIEi'-

S.G.S. ARTS COLLEGi'
TIRUPATI



Details of the Course

Name of the Certificate Course

Batch

Timing

No. of studentV Dept/Year/ Course Duration:

Venue

Eligible Groups

Trainers

Certificate

Course Coordinator

MS-Office

)

Theory: 4:00 PM to 5:00 PM

Practical: 8:00AM to 9:00AM

60/ Comp.Science/ 2016- l71 40 Hours

Theory: Room No 215

Practical: Comp.Science Lab

Il Year B.Sc MPCS, MSCS, MPC, MPS

N.Jayalakshmi, D.Chaithanya Kumar

Yes

Sri P.Udaya

'Ti['t,.n1 g?,ij1L,rir ! i i r: ; Fe

Tt.,.



DeDartmen t of Computer Science:

MS-OIIice Certificate Course Students Name List Batch I

Class Roll No

I Anjan Kumar Pottiramigalla II B.Sc. (MPCS) EM 17491

2 II B.Sc. (MPCS) EM 17492

3 Ashok Kanimeni II B.Sc. (MPCS) EM 17493

4 Bharath Kumar Reddy Kamireddy II B.Sc. (MPCS) EM 17494

5 Bhargav Embeti II B.Sc. (MPCS) EM 17495

6 Brahmaiah Sandu II B.Sc. (MPCS) EM 17496

7 Devarabetta Thimmaguru II B.Sc. (MPCS) EM 17497

8 Harshavardhan Sadda II B.Sc. (MPCS) EM 17498

9 Hima Vamsi.P ll B.Sc. (MPCS) EM 17499

l0 Joseph Merugumolu II B.Sc. (MPCS) EM 17500

II B.Sc. (MPCS) EM 17501

t2 Kartheek Kumar Reddy.D II B.Sc. (MPCS) EM 17502

l3 Lokesh Kommala Il B.Sc. (MPCS) EM 17503

t4 II B.Sc. (MPCS) EM 17504

l5 ll B.Sc. (MPCS) EM 17505

l6 Manohar Bandari II B.Sc. (MPCS) EM 17506

Manoj Kumar Reddy Beemireddy ll B.Sc. (MPCS) EM 17507

Mohana Krishna Bandaram II B.Sc. (MPCS) EM 17508

l9 Mohini lrri II B.Sc. (MPCS) EM 17509

70 Om Prakash Aaramadaka ll B.Sc. (MPCS) EM 17510

2t Pavan Kumar Anderi II B.Sc. (MPCS) EM 17511

22 Pavan Kumar Guttapalli II B.Sc. (MPCS) EM 17512

23 Prabhakar Badikela II B.Sc. (MPCS) EM 17513

24 Praneeth Kumar Uppuluru II B.Sc. (MPCS) EM 17514

25 Prasanth Muppuri II B.Sc. (MPCS) EM 17515

26 Rajesh Akasam ll B.Sc. (MPCS) EM 17516

27 Ram Prasad Korlakunta II B.Sc. (MPCS) EM 17517

Ravali Baduru II B.Sc. (MPCS) EM 17518

29 II B.Sc. (MPCS) EM 17519

S.No Name of the Student

Arjun Karli

ll Jyothsna Kondru

Madhu Undela

Mahesh Avisineni

t7

l8

28

Ravi Durga Prasad Donti



S.No Name of the Student Class Roll N<r

30 Ravi Teja Mekala II B.Sc. (MPCS) EM 17520
JI Sai Prakash Penchili II B.Sc. (MPCS) EM 17521

32 Satish Veligiram II B.Sc. (MPCS) EM 17522

JJ Shaik Adam Basha II B.Sc. (MPCS) EM 17523
34 Sravani Pidugu ll B.Sc. (MPCS) EM 17524
35 Sreekanth Chejarla II B.Sc. (MPCS) EM 17525
36 Surekha Pulluru II B.Sc. (MPCS) EM 17526
37 Suri Babu Motikala II B.Sc. (MPCS) EM 17527

38 Tejaswini Manyam ll B.Sc. (MPCS) EM 17528
39 Thulasi Babu Ardhamala II B.Sc. (MPCS) EM 17529

40 Umapathi Pamula II B.Sc. (MPCS) EM 17530

4t Ajith Kumar Vembakam II B.Sc. (MPC) TM 17425

42 Chandra Mouli Degala II B.Sc. (MPC) TM 17426
43 II B.Sc. (MPC) TM 17427

44 Hemanthkumar Yanadannagari II B.Sc. (MPC) TM 17428

IVIahesh Babu Vakiti II B.Sc. (MPC) TM 17429

4b Mahesh Madhavaram II B.Sc. (MPC) TM 17430
47 Nagaraju Pothrna II B.Sc. (MPC) TM 17431
;18 Nageswara Velpula II B.Sc. (MPC) TM 17432
49 Pavan Kalyan Naik Vaditiya ll B.Sc. (MPC) TM 17 433

50 Chakradhar Vyas Bola II B.Sc. (MPC) EM 17456
5l Chandu Karnamkota II B.Sc. (MPC) EM 17457

52 Chiranjeevi Tankam II B.Sc. (MPC) EM 17458

53 Ganesh Mandadhi II B.Sc. (MPC) EM 17460

54 Gnanasekhar Chittathoor ll B.Sc. (MPC) EM 17461

55 Hanumanthu Yerukala ll B.Sc. (MPC) EM 17462
56 Hari Prasad Byrisetty II B.Sc. (MPC) EM 17463

57 HEMANATH-POOJARIS II B.Sc. (MPC) EM 1746/
58 Jagadeesan A.K II B.Sc. (MPC) EM 17465

59 Mahesh Pasapala II B.Sc. (MPC) EM 17466

Mahesh Ravula II B.Sc. (MPC) EM 17467

HE
DtPAXTittilI Of co8lPUTIR 5Ct:::-

S.G.S. ARTS COLLEG:,
TIRUPATI

Gunasekhar Reddyvari

45

60



Dena ment of comDuter Science:

MS-OIIice Certificate Course Students Name List Batch 2

S.No Name of the Student Class

Allipeera Dudekula II B.Sc. (MSCS) EM 17541

2 Anjali Bodannagari II B.Sc. (MSCS) EM 17542
J Anjineyulu Vijayanagaram Il B.Sc. (MSCS) EM 17543
4 Anusha Minuku II B.Sc. (MSCS) EM 17544

5 Bhuvanesh Ragam II B.Sc. (MSCS) EM 17545
6 Chalapathi Arava II B.Sc. (MSCS) EM 17546
7 Chandra Sekhar Nama II B.Sc. (MSCS) EM 17547

8 Deva.G II B.Sc. (MSCS) EM 17548
9 Dharani Kuamr.M II B.Sc. (MSCS) EM 17549
t0 Ganesh Kumar Gujjala II B.Sc. (MSCS) EM 17550

lt Hemanth Mekala II B.Sc. (MSCS) EM 17551

t2 Himavanth Sanambatla II B.Sc. (MSCS) EM 17552
I3 Jagadeswari Sakam II B.Sc. (MSCS) EM 17553
t4 Kiran Kumar Chakali Il B.Sc. (MSCS) EM 17554
l5 Lokesh Chitteni II B.Sc. (MSCS) EM 17555

16 Lokesh Pasupuleti II B.Sc. (MSCS) EM 17556

t7 Loknath Upendram II B.Sc. (MSCS) EM 't7557

l8 Madhu Peta II B.Sc. (MSCS) EM 17558

l9 Manikanta Balagani II B.Sc. (MSCS) EM 17559

20 Meghana Maddela Il B.Sc. (MSCS) EM 17560

2t Muni Sai Kumar Ponna II B.Sc. (MSCS) EM 17561

Narsappa Pandikona II B.Sc. (MSCS) EM 17562
23 II B.Sc. (MSCS) EM 17563

Raju Singadi Il B.Sc. (MSCS) EM 17564
25 Rethish Sai.JM Il B.Sc. (MSCS) EM 17565

26 Rupesh Kanakappagari II B.Sc. (MSCS) EM 17566

27 Sai Kumar Anthati tl B.Sc. (MSCS) EM 17567

28 Sai Kumar Kesani II B.Sc. (MSCS) EM 17568

29 Sai Kumar.U II B.Sc. (MSCS) EM 17569

30 Sandeep Chakram II B.Sc. (MSCS) EM 17570

Roll No

22

Raja Dhannasi



S.No Name of the Student Class Roll No

3l Santhosh Kumar Kantineni II B.Sc. (MSCS) EM 17571

32 Sasidhar Nagella II B.Sc. (MSCS) EM 17572

33 Sathish Kumar Gurrappagari II B.Sc. (MSCS) EM 17573

34 Srinivasulu Bapana II B.Sc. (MSCS) EM 17574

35 Sumalatha.B II B.Sc. (MSCS) EM 17575

36 Sunil Pasupula II B.Sc. (MSCS) EM 17576

37 Supriya Didi II B.Sc. (MSCS) EM 17577

38 Suresh Gonimadathala II B.Sc. (MSCS) EM 17578

39 Surya Guggilla II B.Sc. (MSCS) EM 17579

40 Vamsi Krishna Ghattamaneni II B.Sc. (MSCS) EM 17580
.11 Vara Prasad Sige II B.Sc. (MSCS) EM 17581

Venkatesu Appannagari II B.Sc. (MSCS) EM 17582

43 Venkatramana Vrjayanagaram II B.Sc. (MSCS) EM 17583

44 Venugopal Putakala Il B.Sc. (MSCS) EM 17584

45 Vinay Jadapalli II B.Sc. (MSCS) EM 17585

46 Vishnu Vardhan Mamuduru Il B.Sc. (MSCS) EM 17586

47 II B.Sc. (MSCS) EM 17587

48 Yuvaraju.S Il B.Sc. (MSCS) EM 17588
,+9 Ashok Kumar Kuchapu ll B.Sc. (MPS) TM 17595

50 Chandrudu Jadipi ll B.Sc. (MPS) TM 17596

5l Gurunadh Sammeta II B.Sc. (MPS) TM 17597

52 Jayakumar Obulapuram II B.Sc. (MPS) TM 17598

53 Raja Mohan Boddu Boina II B.Sc. (MPS) TM 17599

54 Rakesh Bonasi II B.Sc. (MPS) TM 17600

55 Rakesh Paramaala Il B.Sc. (MPS) TM 17601

56 II B.Sc. (MPS) TM 17602

Vasu Bandla II B.Sc. (MPS) TM '17603

58 Viswanath Burru II B.Sc. (MPS) TM 17604

59 Sreekanth Oduguru II B.Sc. (MPC) EM 17483

60 Vinodh Kumar Pandigunta Il B.Sc. (MPC) EM 17485

DTPARIMENT Of ( il!

s.G,s. ARTS eoLLEGL
TIRUPATI

Yeswanth Gownipalli

Sai Kumar Bommala



STUDENTS ATTENDANCE LIST BATCH I (THEORY 8:00 AM to 9:00 AM
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I 17491 Anjan Kumar Pottiramigalla ? ? ? P P P fl P P 7 P P P P P A P P V P
17492 Arjun Karli2 P P A P P P P P F p P P P P P P P P A P

J 17493 Ashok Kanimeni P P P P P P P P A P P P P P P P P P P P

17494 Bharath Kumar Reddy Kamireddy4 P P P P P A P 7 P P P P P ? P P ? P P P
17495 Bhargav Embeti5 P P P P P ? P P ? P P P A P P P P P P P

6 Brahmaiah Sandu P P r A f P P P P P P P P P P P P P F P
7 Devarabetta Thimmaguru P P A P P P P P P F P F P P P P P p P P

17498 Harshavardhan Sadda P P P P P P D P Ft P P P P P P P P F P P
9 17499 Hima Vamsi.P P P P ? P P ? P ? P P P F P P P n p P A

17500 Joseph Merugumolul0 P ? ? ? P P A P P a P P P P P P P P p P
11 17501 Jyothsna Kondru P ? P P ? P ? P a P ? P r r P P P A P p

17502 Kartheek Kumar Reddy.D12 A F P P ? P P P P P ? P P P ? P P fr P P
17503l3 Lokesh Kommala t> P e P P P P ? P P c P a P fr P P P P )9

t4 17504 Madhu Undela ? P P P P P P ? tr P P P P P P r ( P P P
17505 Mahesh Avisinenil5 P P P P h P P P tP a P P P P P P P P A P
'17506 Manohar Bandaril6 P F P P P p A A P ? P P P P F P P P P P
17507t7 Manoj Kumar Reddy Beemireddy P b D PP P P f> P P P P P p P r P tr fP

18 17508 Mohana Krishna Bandaram P P P P A ? P P P P P p fr P P F P P P P

SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office"
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27 Ram Prasad Korlakunta

? ? P P P ? ? A r P A ? f ? I f P P P P
28 17518 Ravali Baduru

P ? ? r P P ? ? r r ? ? r ? f P r P r P
29 Ravi Durga Prasad Donti ? ? A f f ? ( ? r r P ? r A ? ? P r P
30 17520 Ravi Teja Mekala
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36 Surekha Pulluru

? A ( r f r r ? ? P A ? r ? I P P r P P
)l Suri Babu Motikala
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52 Chiranjeevi Tankam
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STUDENTS ATTENDANCE LIST BATCH I (PRACTICAL 4:00 PM to 5:00 PM
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I 17491 Anjan Kumar Pottiramigalla ? ( ( ? ? ( ( r r A ? r A r r r ? ? ?
2 17492 Arjun Karli r r r ? ? ? ? ? A ? r ? ? ? f ? ? ? R f
J Ashok Kanimeni f r ( I ? ? ? ? ? ? ? ? r ? P R t ? ? A
4 17494 Bharath Kumar Reddy Kamireddy f t ? ? ? P ? ? ? ? ? P P ? ? I f r ? P
5 17495 Bhargav Embeti

? A r ? P ? ( ? A r r r ? ? f ? f P r P
17496 Brahmaiah Sandu

P I I ? ? ? ? ? P ? P ? P A ? ? t ? f ?
7 17497 Devarabetta Thimmaguru ? r ? P A ? ? ? t r ? r f ? f A ? ( ? P

174988 Harshavardhan Sadda P ( ? ? ? ? ? ? ? ? f r P P r r r ? f f
9 Hima Vamsi. P ? A ? ? ? ? ? ? P ? f P ? P P P A I ? ?

17500 Joseph Merugumolu
? Y ? P I ? ? ? r r P A P P P P P I A P

17501t1 Jyothsna Kondru r P ? ? ? P ? ? ? P r ? P P P P ? ? ? P
t2 17502 Kartheek Kumar Reddy.D A r ? ? I ? ? ? P P ? ? P ? A ? P ( ? ?
l3 17503 Lokesh Kommala ? ? ? ? ( ? P ? A ? P P A ? ? r P ? r ?
t4 Madhu Undela ? ? A ? ? ? r P 9 ? R ? f r ? r ? ? P P
l5 17505 Mahesh Avisineni r ? ? ? ? ? P ? ? P ? ? P P ? f ? ? ? P
16 17506 Manohar Bandari ? A P P r ? ? A r P ? I ? f r f f P f P
l7 17507 Manoj Kumar Reddy Beemireddy ? ? ? P ? A ? ? ? P A ? ? ? r ? r P f r

SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office"
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l8 17508 Mohana Krishna Bandaram ? P A f ? ? ? P ? A ( ? P P ? r P ? P P

17509 Mohini lrri P ? ( ? ? P ? ? ? ? r ? ? ? P ? P ? ? r
20 Om Prakash Aaramadaka ? ( ? I ? A ? ? ? ? ? ? r P P P P A r P

2t 17511 Pavan Kumar Anderi I ? ? ? ? P ? ? A I ? ? r A ? ? ? ? P P

22 Pavan Kumar Guttapalli ? r ? A f ? ? P P P ? r f ? A r ? N r ?

23 17513 Prabhakar Badikela I ? t ? r P f ? P r f r fl Y ? ? ? f A f
17514 Praneeth Kumar Uppuluru ? ? ? ? ? ? P P ? ? r P ? ? ? A ? f ?

25 17515 Prasanth Muppuri ? ? ? ( Y ? R ? ? ? ? r ? ? ? ? A ? ? r
26 17516 Rajesh Akasam ? ? ? f A ? ? ( r ? r ? I A ? P P r r f
27 Ram Prasad Korlakunta ? A P Y ? ? ? ? ? P r ? 7 P P ? P r f P

28 17518 Ravali Baduru ( ? ? A ? P A P P P r ? I P ? r P t ? ?

Ravi Durga Prasad Donti P ? P 1 P P P P A ? ? P f P fl P P P f f
30 Ravi Teja Mekala ? ? ? ? P ? ? P ? ? P P P ? P r A P P

31 17521 Sai Prakash Penchili ? ? ? Y ? A ? P ? P ? P P f P P I ? A f
32 17522 Satish Veligiram ? A ? P ? ? r r r A r r ? ? P P r ? r P

55 Shaik Adam Basha ? Y ? ? ? ? ? r ? r A ? r r r P A ? P r
34 17524 Sravani Pidugu ? ? ? ? ( ? r f ? ? f r P r P ? P ? r f
35 17525 Sreekanth Chejarla r ? A f I r ? ? A ? f r r P P r f ? r P

36 Surekha Pulluru ? ? P { ? ? ? ? ? ? ? A ( r r ? P I ? A

37 Suri Babu Motikala ? ? ? ? r r r ? P A r ? r A P ? r ? P ?
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38 Tejaswini Manyam I ? r ? r ? ? ? A P ? ? P P P ? A Y f ?
39 17529 Thulasi Babu Ardhamala ? ? A f ? ? ? P ? ? ? ? r P P r r A P r
40 17530 Umapathi Pamula r ? ? ? P ? A r ? ? ? ? ? A ? P r ? f P
4l Ajith Kumar Vembakam

Chandra Mouli Degala

( f ? ? r ? ? ? r r I P f r f ? f Y r P
42 I A ? r ? ? ? P ? A P P ? I ? P ? ? ? ?
43 17427 Gunasekhar Reddyvari

P ? ? r I ? I A ? ? r P ? ? P ? A ? ? ?
44 Hemanthkumar Yanadannagari

P ? ? ? ? ? P P ? P I A ? ? ? r P ? A f
45 17429 Mahesh Babu Vakiti t ? f Y ? A P ? ? r r r ? A r r ? Y r I
46 17430 [/lahesh lvladhavaram

? ? ? A I r P ? ? ? r r P I A r r P r P
47 17431 Nagaraju Pothina ? r ? ? ? ? P P f t ? ? r I ? P P Y A P

48 Nageswara Velpula ? Y P Y f ? A ? ? Y P A ? ? ? P ? r I f
49 17433 Pavan Kalyan Naik Vaditiya r ? ? ? A I P ? r P Y r r P ? R f ? ( f
50 17456 Chakradhar Vyas Bola I A ? r f ? ? ? ? r r P ? ? r r f A I r
5l 17457 Chandu Karnamkota ? ? ? ? I P r P r ? P ? t r r f r ? r f
52 17458 Chiranjeevi Tankam r ? A ? ? r f r r I A ? P r P I P ? r f

Ganesh Mandadhi
Y t ? ? ? P A ? r ? r ? f ? ? f A Y ? ?

54 17461 Gnanasekhar Chittathoor ? f P r ? P ? r r r r ? r P P r r ? I P
55 17462 Hanumanthu Yerukala r t r ? A ? r r f r r r ? r ? A r P r ?
56 17463 Hari Prasad Byrisetty ? ? ? r ? P A P r ? f P P A ? P P r P r
57 17464 HEMANATH.POOJARIS ? ? ? ? r A ? r ? P A r P r r ? P r r

o\

al

€

17528

17432

53

?

17460

17428

17426
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17465 Jagadeesan A.K ? ? A t ? t ? ? ? ? ? ? A ? P P ? f ? P
59 17466 Mahesh Pasapala ? ? ? ( ( P f A ? ? ? ? ? ? ? f ? A ? P
60 17467 Mahesh Ravula

? ? r ? ? ? ? ? ? A r f ? ? P r R ? r r
D[PA

s,
llriltt I of comPUrSE r:(:....-,
G.s. ARTs coLr:

TIR PATI
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-OIfice"
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NRoll No

Name of the
Student

S.No

r ( ? ? ? ? ? ? ? A ? ( P ( P RAllipeera Dudekula r r ( (I

Anjali Bodannagari ? P A ? ? ? ? ? ? P P P ? P P r P A P r175422

? ? P P P P ? ? ? ? P r P I ? ? ? I17543 Anjineyulu Vijayanagaram ? ?J

? ? A ? P ? I ? P ? P P P ( A tAnusha Minuku ? P P ?4

A p ? ? P P P f ? f PBhuvanesh Ragam ? ? ? Y ? ? r f ?5 17545

? A ? I P ? ? ? ? ? ( P P f r ? P I ? ?Chalapathi Arava6

I P ? ? ? A ? ? P ? P ? P f ? r P ? A f17547 Chandra Sekhar Nama7

( ? ? ? ( ? A ( I P I R P P P r P ? rDeva.G ?8

? A ? P P ? P A ? ? P P r P r I A P17549 Dharani Kuamr.M ? P9

? P A ? ? f ? A P t f17550 Ganesh Kumar Gujjala ? ? ? ( r ? ? ? P10

Hemanth Mekala ? A ? I I I A ? ? P ? P P ? P P r Y ? P175511l

? ? A P ? P A ? P Y ? ? r P r P P P17552 Himavanth Sanambatla ? ?t2

P P I P PJagadeswari Sakam P ? ? I r ? r ? P P P p f I (1755313

? A ? ( ? R ? P ? ? ? ( r P r P f f /Kiran Kumar Chakali ?t4

I P P P I R I P P P R I17555 ? ? ? ? ? P P Pl5

I I P tLokesh Pasupuleti I ? ? ? ? A ? tf ? r ? A ? f r I17556l6
Loknath Upendram ( r ? ? ? ? ? f f A P P ? ? P r { P ? P17557t7
Madhu Peta ? ? ? f ? ? r P ( P ? p ? P r f P r P P17558l8

I ? r ? r r r A ? r I ? r r I ?17559 Manikanta Balagani ? ? A I19

4:00 PM to 5:00 PM
o\
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6
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at

o\

17544

Lokesh Chitteni

17541

17546

17548

17554
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20 17560 Meghana Maddela ( ? R ? ? ? ? ? ? ( A f r ? P P ? r ? P
21 Muni Sai Kumar Ponna ? ? ? r A P ? ? A ? ? r P ? P P P Y f P
22 Narsappa Pandikona I A ? ? ? ? ? ? ? ? ? P P ? ? ? ? A P ?
Z) 17563 Raja Dhannasi I ? ? ? P P ? ? ? I ? ? ? ? I ? P P f P
24 17564 Raju Singadi ? ? P ? A e ? ? P ( A ? P ? f ? f p p f
25 Rethish Sai.JM P ? ? ? ( P A ? ? ? P P ? P ? ? fr ? P P
26 17566 ? ? P ? ? ? f f I A P I P I f ( ? ? r f
27 Sai Kumar Anthati ? P P r ? ? A ? ? ? ? ? ( f r P P ? A f
28 17568 Sai Kumar Kesani ? ? ? A ? P r ? ? ? ? P ? r f A ? r ? f
29 17569 Sai Kumar. U ? ? ? ? I P P ? A ? ? P P P ? P ? ? f A
30 Sandeep Chakram ? r P ? ? ? ? ? ? ? ? P P P P f P P P P
31 Santhosh Kumar Kantineni ? ? ? Y A P ? A ? ( P r I t f I P P f P
32 17572 Sasidhar Nagella ? ? ? ? ? A P I I P P P A ? P I ? ? I r
33 Sathish Kumar Gurrappagari , ( ? Y ? ? ? r f f ? P P ? A P ? ? P P
34 Srinivasulu Bapana ? r ? A ? ? P P P P P P ? P P ? ? P A P
35 17575 Sumalatha.B P ? A I ? ? ? A P P ? P P P ? ? ? p r I

Sunil Pasupula I ? P r ? ? P r A f P r r P fr f P ? r f
37 Supriya Didi r ? ? ? ? ? r P P ? r P P ? P P ? A P P
38 17578 Suresh Gonimadathala ? ? I r r A I P P ? ? ? P ? ? A P I f f

17579 Surya Guggilla ? f A I f r ? P A r ? ? P ? ? P P I f ?
40 Vamsi Krishna Ghattamaneni ? ? P V P ? p ? P P P A ? P P n ( r ? f
4l 17581 Vara Prasad Sige ? ? ? P A ? r ? P P P P ? ? A P P ? f f

17565
Rupesh Kanakappagari

17573

36

39

17561

17562

17567

17570
17571

17573
17574

17576
17577

17580
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42 17582 Venkatesu Appannagari r ? A ? r ? ( ? ? P P Y ? P ? ? P ? P I
43 Venkatramana Vijayanagaram ( ? ? ? f ? P A ? ? P P ? ? P ? P A P r
44 17584 Venugopal Putakala I ? ? ? ? A ? ? ? f ? f f ? r ? f Y A ?
45 Vinay Jadapalli ? ? ? ? A ? ? ? ? A ? p ? ( ? P P I ?

,/

46 '17586 Vishnu Vardhan Mamuduru r ? ? A ? ( ? P V ? f A P P ? P I Y I I
47 17587 Yeswanth Gownipalli ? ? ? ? I P A ? ? ? I ? ? P

t7r p ? ? A I
48 17588 Yuvaraju.S ( ? ? Y ? ? P ? ? ? P f ? f ? n P I P n
49 17595 Ashok Kumar Kuchapu ? ? ? ? ? P P I f ? P ? ? r f f r f ( P

17596 Chandrudu Jadipi ? ? A ? ? ? p ? A ( Y P P r f r ? ? ? P
17597 Gurunadh Sammeta r A ? I ? ? ? r P ? A ( ? r f I r v r P

52 17598 Jayakumar Obulapuram t ? ? ? P ? ? ? P r P I A P P P P I A r
53 17599 ? ? ? ? A f ? ? ? P P ? ? P r A P p P P
54 17600 Rakesh Bonasi P p I ? P P A ? P f ( I Y r A P f f r
55 17601 Rakesh Paramaala ? ? t ? ? ? P ( P ? P P I I ? ? r P / P

56 Sai Kumar Bommala ? A ? Y f ? ? ? P A ? P P P P ? P ? p (
17603 Vasu Bandla ( ? ? ? A t P r ? f ? n f P r P r ? P f

58 17604 Viswanath Burru r ? ? P ? A ? r ( P P ? ? P ? ? P I A r
59 17483 Sreekanth Oduguru ? r A P r r r f r ? r r P ( r ? r A P P
60 17485 Vinodh Kumar Pandigunta ( ( ? P A f ? f ? ? P P P P f ? A r ? I

DEPARIilIENI OT COMPUT" T(
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office"

STUDENTS ATTENDANCE LIST BATCH 2 (PRACTICAL 8:00 AM to 9:00 AM
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17541I Allipeera Dudekula r ( a f a ( (? I I A R G r ( rr'
U ? 0 P

2 17542 Anjali Bodannagari ( ( R ? ? I q 0 R 0 e e U' F e ? f P
, Anjineyulu Vijayanagaram r a ? ? P ( g ft,\ K P e 0 P P F ? V
4 Anusha Minuku ? P 0 ? 0 P a \\ ( \, (f ( ( 0 a 0

a
\ ? r e

5 Bhuvanesh Ragam fl P ( A q 0 0 (T ? e I 0 P I r 0 ? P
p

6 17546 Chalapathi Arava r a ( ? ( C)\ P a R 3 r r P F r ? a>\ P
Chandra Sekhar Nama 0 C P ? 0 ( 0 ( K ? () (? R e r>(( n

\t e ?
8 Deva.G R A a r A e 0 a a ( ( q R ? 0 ( p \I G'
9 Dharani Kuamr.M 3 R r ? a q V ? F I (? P P ? a 3 r I ?

1755010 Ganesh Kumar Gujjala P ? P h a 0 R a I 3 0 ( ( a ? ? r I
l1 17551 Hemanth Mekala f ( (? ?

o
\ ? 3 ? e P \{ \\'

)
? P p t (

17552 Himavanth Sanambatla r ? r ? a q (t)\ ( (/ ( o ( ? tr ( e P a (
13 Jagadeswari Sakam ? ( ( ? q r V B

t'>
\ a \Y P I P ? P 3

17554 Kiran Kumar Chakali ? ( P
q a q ( a a 3 P I P

l,)( 0
17555l5 Lokesh Chitteni r r h Y ( ( R R G a P )

C 0 r ( P ? e
17556l6 Lokesh Pasupuleti r'>

\1 r (? ? E R E ( 0\l
r)v P ? ( 0 ? p 3

17 Loknath Upendram 3 I ( P R (? R q ( )
I 0 e (\' n/ F D

u 3 P e
l8 Madhu Peta ? r 0 ? P ? ( ( )

\ A o
K \ 3 ( D

\ f ?
(>
ll P

19 Manikanta Balagani r r a P ( /',
K e C P ( I P 3 U P r ( (
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20 Meghana Maddela ( ( ( ? a r O I
R e ? ? ? P ? + ? ? P

21 17561 Muni Sai Kumar Ponna a (2 o
K ? t{ ( k' a ( a ( ? ? ? r p P r + P

22 Narsappa Pandikona a a ( Y .A ? P ( P ? p * ? P ? P P A ? P
23 17563 p ( ) ( q a ( 0 P P P ? ? P ? ? ? P
24 17564 Raju Singadi 0 o e ? ( K F a a ? P P ? p ? ? ? r P
25 17565 Rethish Sai.JM 7 ? P ? ( ( P A r A ? P P ? ? P
26 17566 0 0 0 ? \r ( ? C ( r P P P p P P P P P f
27 17567 Sai Kumar Anthati B ( 0 ? a 0 0 P (? P P ? P ? r ? P P ? P
28 17568 Sai Kumar Kesani 0 I ( Y ( 0 a (/ P P P P P r r r ? r f
29 Sai Kumar.U a a P A a ? P P P P P A r P ?tpf r
30 Sandeep Chakram P ? I A a 3 R O a P P P P P P P P P P
31 17571 Santhosh Kumar Kantineni )

J P 0 I ( c P (? p P P * P P f /' ? ? P
-) -/. Sasidhar Nagella ? 3 a ? 0 \t ? ( r P r p p P P P A P P
33 Sathish Kumar Gurrappagari 3 r ( Y a o ) r P P P A P P r p r A
34 17574 Srinivasulu Bapana 3 P ? q ( \( ( P P P ? P P P P P f

17575 Sumalatha.B P P p (? e P ( P A P r F P P ? P ? ?
36 17576 Sunil Pasupula ( p ? ( 0 It' ( ( a r p ? P ? ? * P I / P
37 17577 Supriya Didi 0 ( P r t' (

T lt d P P P P P P r P I k
38 17578 Suresh Gonimadathala ot 'D

LI
r I e (? i P \ P p P P A r e P I P ?

39 17579 Surya Guggilla r P e ? 0 F' ( P ( P P p P P P r r I r P
40 17580 Vamsi Krishna Ghattamaneni

)
P A ? q ? P P A ? P r P r P P P

4l 17581 Vara Prasad Sige r r r ? a (?
\ {' ( Y P ( p P r r P r f
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42 17582 Venkatesu Appannagari ? ? ? ? ? ? A P ? ? P P P ? ? A 0 ? P ?
43 17583 Venkatramana Vijayanagaram P A ? ? P P P P P P P p p A P a ? I P P
44 Venugopal Putakala ? P * ? ? P P A ? P P P P ? P ? ? P P
45 Vinay Jadapalli ? P D I A P P P r P ? P ? A- P P ? P r
46 17586 Vishnu Vardhan Mamuduru ( ?+ P ? P p P ? P P r P p ? ? A P ? t' P
47 Yeswanth Gownipalli r ? A ? P P ? + ? P ? r P p P P P ? p
48 17588 Yuvaraju.S ? P P ? P & ? ? P f, P ? ? P p f P I P P
49 17595 Ashok Kumar Kuchapu P r ? ? r r / P & P ? P p p P A p ? P
50 17596 Chandrudu Jadipi P P ? ? P P P p P P A P p p P P ? ( P
5l 17597 Gurunadh Sammeta P P P ? fi- P P ( p P P P F P P P p I r p
52 17598 Jayakumar Obulapuram r P ? ? ? ? p A ? p P p P ? A P p A p P
53 17599 ? ? 2 ? ? P ? P ? P / P P p P P )+ r P
54 Rakesh Bonasi p p P I f P A P v P P 0 P P P / r P p
55 17601 Rakesh Paramaala f A ? ? f p r r p P P P A P P P r ? P P
56 Sai Kumar Bommala P I ( P ? / r p P P P P P P * P P P p
57 Vasu Bandla r f ? p 7 P 0 P 4 P p P P P P p ? p r

17604 Viswanath Burru ? f p p p 0 ? P r P P F A p P p P ? P r
59 17483 Sreekanth Oduguru p P ( ? 12 {) ? r p k D P p P P P ? P P
60 17485 Vinodh Kumar Pandigunta P p P r P r r P D P P P P / P P P P P
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SGS ARTS COLLf,GE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office"

STUDENTS TEST ATTENDANCE BATCH 1

Date: l5-02-2019 Timin : {:00 to 5:00 PM

S.No Roll No Name of the Student Signature

I 17491 Anjan Kumar Pottiramigalla Q. 4n2n.. kr.rr?l
2 Arjun Karli LY'r r rrr Var ti

-) Ashok Kanimeni -t
Ahrlx Lan\xe-

4 17494 Bharath Kumar Reddy Kamireddy H-:oaL Y t,moX(ed.l- -,
5 Bhargav Embeti I1L--,, ar^ J^rf
6 Brahmaiah Sandu Rn^*J \-bA <anLt
7 17497 Devarabetta Thimmaguru bara-,robeito- thi**o a,,r,,
8 17498 Harshavardhan Sadda \. +t^r'rL vnAL:"
9 17499 Hima Vamsi.P P-4{,Yn Vamq',

17500 Joseph Merugumolu Er(Pdr
ll 17501 Jyothsna Kondru

t2 17502 Kartheek Kumar Reddy.D D lorthrar)c B!.o,\a\
l3 K. L-ov"^L

Madhu Undela t). u)uu
t5 Mahesh Avisineni M^r'^X -Arteerrz..i
t6 17506 Manohar Bandari t4 rrl,tnn lrr,l.a

17507 Manoj Kumar Reddy Beemireddy Llo,n',i, b,,^ ot
l8 17508 Mohana Krishna Bandaram S-tnD\o,ro-KY(sN.o--

17509t9 lvloh in i lrri 'i 1.4D1.,-,h\
17510 Om Prakash Aaramadaka *r,r aUrh -A cr:tafr^adala
1751121 Pavan Kumar Anderi -A ?o"ol \<urnov

22 17512 Pavan Kumar Guttapalli Ourar,r l4rrmaJc Gutra r"J t i
1751323 Prabhakar Badikela

I
hrnllao-h-o,a rrcr tibr-lo

Praneeth Kumar Uppuluru o For^{lturr"r
25 17515 Prasanth Muppuri P6osOrL{b rn\tP?rld
26 17516 RaJesh Akasam Q^',e sL -{ta, rr'^
27 17517 Ram Prasad Korlakunta Pl^^ or*^)
28 17518 Ravali Baduru Bo^hli rk)un,
29 17519 Ravi Durga Prasad Donti RofrDufr o cr.ogoc{ }crdi
30 17520 Ravi Teja Mekala M.&lrrfl-Se--

3l 17521 Sai Prakash Penchili *n ttr^llo^{.-,-

17493

17495

l0

UfqAitq-;-

17503 Lokesh Kommala

t4

17505

t7

20

24

17492

17493

17496

17504

17514



S.No Roll No Name of the Student Signature

32 17522 satish veligiram

33 Shaik Adam Basha sharr
34 17524 Sravani Pidugu

35 Sreekanth Chejarla c
17526 Surekha Pulluru

5t 17527 Suri Babu Motikala

17528 Tejaswini Manyam arplw11,1

39 17529 Thulasi Babu Ardhamala

40 17530 Umapathi Pamula

4t 17425

42

ith Kumar Vembakam

Chandra Mouli Degala o

43 Gunasekhar Reddyvari

44 Hemanthkumar yanadannagari

45 Mahesh Babu Vakiti

46 Mahesh Madhavaram

47 17431 Nagaraju Pothina

48 17432 Nageswara Velpula

49 17433 Pavan Kalyan Naik Vaditiya

50 17456 Chakradhar Vyas Bola

5l 17457 Chandu Karnamkota
LT

52 Chiranjeevi Tankam

53 17460 Ganesh Mandadhi

54 17461 Gnanasekhar Chittathoor

55 17462 Hanumanthu Yerukala

56 Hari Prasad Byrisetty

57 17464 HEMANATH.POOJARIS

58 Jagadeesan A.K

59 17466 Mahesh Pasapala P
OU 17467 Mahesh Ravula

DTPARIIUII{I OI, ;. ,s.c.s. ARTg i,{;
TIRUPATI

a*ishvelioirnrn

36

38

17426

17427

17429

17458 -f C\i^crrr..tvgVL-
r,1'

I

Irsn

17525

17428

17430

17463

17465



Date: l5-02-2019 Timin : 4:00 to 5:00 PM

S.No Itoll No Name of the Student Signature

I 17541 Allipeera Dudekula Al)-cntvo Dtlott,l,t
2 17542 Anjali Bodannagari -Airti F^;;";;

Anjineyulu Vijayanagaram

4 Anusha Minuku

5 Bhuvanesh Ragam A, {\--\."Nc6eg}..
6 Chalapathi Arava A c hay'oPall-?
7 17547 Chandra Sekhar Nama

8 Deva.G

9 Dharani Kuamr. M t\4 . tr>lb&:.rri k-,rr"h,
Ganesh Kumar Gujjala A . G^s.c9<ln. \<-'ssr.s-V

ll Hemanth Mekala t\4 . .|-ktc-^+t-',
12 17552 Himavanth Sanambatla }}i.r',v
13 17553 Jagadeswari Sakam

t4 17554 Kiran Kumar Chakali Yva{l V-u*/Ai C/n
17555 Lokesh Chitteni c. Lotcc,t\,,-

l6 Lokesh Pasupuleti P. L^ud*\'r
t7 Loknath Upendram t2^5a
l8 Madhu Peta mot\rr pda
l9 17559 Manikanta Balagani $. 

"".a*n'\ 
vc\s}G

20 Meghana Maddela \\. Ss.e.^ac-st0-
1756121 Muni Sai Kumar Ponna

22 Narsappa Pandikona Q. n\sv !.s-Qr?o-
23 17563 Raja Dhannasi D. P^io^

17564 Raju Singadi
IAFoiu c vtalt

25 17565 Rethish Sai.JM

26 17566 Rupesh Kanakappagari Vu?eEh
lt 17567 Sai Kumar Anthati -9t-i E-t t tn ea,t--.-

a28 Sai Kumar Kesani kk *^r&=-^1
29 Sai Kumar. U

!sa.5 kllfia1:rr)
30 17570 Sandeep Chakram *tmAp co d^^,t -"^^ (

31 Santhosh Kumar Kantineni

32 Sasidhar Nagella

SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COIVIPUTER SCIENCE
CERTIFICATE COURSE IN "MS-OfIice"

STUDENTS TEST ATTENDANCE BATCH 2

J \,1 .J Ar.,?.'-'..r.r., ftl
r-^{

l0

17545

17551

17546

efrJ

l5

17557

24

| -:nN-[

17568

<JI
.\(

17543
17544

17548
17549
17550

17556

17558

17560

17562

17569

17571

17572



S,No Name of the Student

33 17573 Sathish Kumar Gurrappagari

34 Srinivasulu Bapana -s*J35 Sumalatha.B

36 Sunil Pasupula {-> . Scrx',\
17577 D. fir.0l,itl-ct

38 17578 Suresh Gonimadathala ..h
39 17579 Surya Guggilla R ..Girrsa
40 Vamsi Krishna Ghattamaneni

4l Vara Prasad Sige Dfi>tgLil
42 Venkatesu Appannagari

Venkatramana Vijayanagaram
-Msld-r,-*^^-^-:44 Venugopal Putakala

45 Vinay Jadapalli

46 17586 Vishnu Vardhan Mamuduru

47 17587 Yeswanth Gownipalli r-q"-
Yuvaraju.S a.

49 Ashok Kumar Kuchapu

50 Chandrudu Jadipi

51 Gurunadh Sammeta a. klxnilAthl
52 Jayakumar Obulapuram

53 Raja Mohan Boddu Boina

54 Rakesh Bonasi

55 17601 Rakesh Paramaala

56 Sai Kumar Bommala 9l t'. br Ll.t'| rtzz-
57 17603 Vasu Bandla \lexr)

Viswanath Burru

59 17483 Sreekanth Oduguru

60 17485 Vinodh Kumar Pandigunta rr;rrr-l l-r t(l-rrfl"gl

TiEAD
0F eciipUleo

T,RL'F4ij

Roll No Signature

e c*l$,sc[-.. L,,..-.9r

Supriya Didi

17574

37

lr./h41 t Y v,ta7n Yz<

"-4\N^ l. ,"r^
43

, ll l
.l- l11lA t, t t- w

17580

17582

17585

48

U

aT ad\^--.h -,.^, ,)
17597

,)nl U,^t 1't rjzv.l ," -,,/
J/|(A.'AJJ,^I
RokBsl Po'.orrnllo

17602

58 17604

cu&airtA

17575
17576

17580

17581

111583
17584
17585

17588

17595
'17596

17597
17598
17599
17600



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-OfIice"

MARI(S SHEET BATCH I
S.No Roll No Name of thc Student lVlarks in Figure Marks in Words

I 16521 Aiay Kumar Thatiparthi +6 Avlq -Cix or.r lt,
16522 Aravindh Raiu Keerthipati fa"tu-*ar ,snltr2 $z-
t6523 Anil Kumar Edagotti q8 €vtq a*l''l onlq

4 L6s24 Balaji Shankar Pasupulati 96 tfntqi; r l-tr (i,
5 Bondili Moth Chathurved Singh 0t*,t eix 6nlqQ6

1.6526 Chaithanya Chamanthi q& ta,ha 0*W enlq
7 16527 Chinna Reddeiah Nama qt) Covt t -faur nr,' lq
8 Dileep Palamani {nYtt -fir. anlqu6

t6529 Gova rdhan Reddy Pula9 tt 2_ Attq-tura snlu
16530l0 Hari Prasad Gutti qq l*WAuv mlu

Harish Van kada ri r-4K *wru 4 phl- o.lq
t2 1.6532 Kalyan Gorla

U

.A,Ylu 6nt'rqo
L6533 Lakshma n Sirri

'Ari 
Ar,i, ontnl3 qq

L6534t4 U2- 4orfq 4loo 6nlv
15 Lokesh Thummala t/8 't*i, 

t-txhr,s{t,l
16536 Mallikarjuna Ganji Ari si* s^l,/Jl6 r/6
1,6537 Mohan Devapathni LU €rYfu $x\r fd+

l8 Manoj Ku mar Kande firlni sf* rsnlqau6
l9 Nagendra Lakkakula qq dmul t,l,,'P*ta hu

16540 Naveen Ba nda u2- Ard +-o dntvl
Naveen Vadde r.tq k,i, 4nu, .!u

22 76542 Pavan Kummara /*; -{^o rntJqL
1654323 q9 4r{, .ao, ^{"24 16544 Rajeswari Avula U{ -4,h'?;x *tt'./

25 Raju Vadde
U

$rrtl Li pht' r'lttl,qu?
26 Ramanjaneyu lu Talari q{ 0'fr"fr u* nnt,
27 Ramanju lu Peetla N1$el"f l,,uqf
28 Ravi Kumar Than bu ut l..t lix'ht rm

'Dnqx (tl

29 Sagar Moorathoti q(/ 0R"vn Aut nl't
16550 Sai Ram .lamlavala q0 U*rlu Mlc/

3l 16551 Sai Ven kata Kishore.G l;v t,l tq/
J- z I

frr1s0

J

6

ll

Lokesh Thota

t7

16s39

20

2l

Prasanth Naik Mude

16548

30

16525

16528

16531

16535

16538

16541

16545

16546

76547

16548

16549



S.No Roll No Name of the Student Marks in Fi ure Marks in Words
32 Satheesh Reddy.K tlq
JJ 16553 Siva Prasad Reddy Kudumula qq
34 16554 Srikanth Nagiripati

Qe, (

16s55 Srinivasulu Annangi q6
36 Srinu Thullur t/& h;r4"rt-u t t ptc
37 16557 Suresh Babu Gari Pavan Kumar L41- I+2"

16558 Thulasi Naik.S 4z-
Vamsi Reddy Dontireddy _qF

40 Vamsi Kila ri cl*
4t 16561 Venkaiah Kasi 9a x

Venkatesh Boya _t 1(D
43 16563 Venkatesh Reddycharla

Lr tl r I

I
44 16564 Vimal Reddy Cheepati qq
45 inod Kumar.K

DL 6Y) I
46 Aravind Kumar.G

I
1641,6 Bhanupriya Pulipati uk

48 76417 Cha nd ra Sekhar Nandyala _q8
19 t641,8 Cha ndu Chinnaponnangi 5O
50 1.6419 Gunasekhar Bodireddy tJ,f
5l L6420 Harikrishna Mambeti ux

I

l
52 Lokesh Bodireddy _q6 attl
53 16451 Akhil Kumar.A q6 9ix an
54 1.6452 Ashok Kumar Rajakara r,l L o
55 16453 Chandra Ku mar Busagani Uz- o 6al
56 76454 Duwuri Raviteja Reddy \

tI_t
57 16455 q6
58 Ganji Midhilesh 9q t

o
59 L6457 Gopi Namepalli _\z

16458 Kalyan Paramala qf,

li!

-hrru -laur x'tlu

U
U

35 M, $< nnLt

38

39 16559

4rttu /
42

16565

o2-

A"i, r ^(*/
ooL+

t6427

ltp
Eswar Gan igapenta

60

I rossz

16556

16559

16s60

16s62

16415

I ro+so

DtF'iflTlIlEllT 0F C0Irt?tiI::, : :,,
S.G.S. ARTS CGLLLJ,.

TIRUPAT'



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office"

Roll No Name of the Student Marks in Figure Marks in Words

I Bhagya La kshm i Pamala (rtr -Podu -laov snl,a
L6572 Bhargav Tirupati t)L Ar'n's;, cn/.ro

J Damodharam Valleri
C.I L o

16574 Ganesh Kuppam Ltt
16575 Gayatri Pathiputturu LI LI 4rri Arv hnlJ

6 Guru Sai Puttu OO- .r$ir|l-,rJo Ehtf,
1,6577 J hansi Rani Ma risetty ut htiv r iv ort7

8 15578 Jyothirmayi Adepalle LLI
l

9 Kavitha Ma ncha la

10 15580 qP -8, i, d Pht'Kt"iX
l1 16581 Mallikarjuna Mekala rll -4"2rt Lt, rrDfi,,

o

12 t6582 Ma llika rjuna Kavili LtL
13 16583 Mamatha Mundlapudi -fr1tt Auy Ri
t4 16584 Mani Pagadala qq M. Auv snil
15 16585 Manoj Kumar Kambagowni Ediga t! "l- o

16585 M ura li. N trU
17 16587 Na rendra Surna m bL 1

I

f X *;
16588 Narendra.T UL .Rvht ;*tT3i
16589 Na raya na Ya la manda Qr $rt-,i ,ioh;AT

20 15590 Naveen Kumar Thatigunti qrP -A-d u;i,*liT
2t 16s91 Pa rushu Ramudu Mandla 50

16592 Pavan Kumar Dasari qA -1"*U tix nnlq
z-) 16593 Prabhakar Pamuru LIA 4''r|t ,Tl, 

^ 
(tntw

1A 16594 Prema Chandu Kalipogu U1- n
LL&N fioo rml

25 Poojitha Pingani \lL- 4rr;^rt"-
26 16595 Priya.G tru Y
27 Rahul.K.C Ltq
28 16598 Rajkumar Nandimangalam t/A 4"+-/ cix sttuI
29 15599 Ra makanth Reddy Vulava la qt '.frr,ru ei*h/,,.nli
30 16600 RAVI KALAIARASI ttb g41siz atllq

0

MARKS SHEET BATCH 2

S.No

2

4

5

7

[.] (.r

Mahesh.M

UL,

Arhi
16

18

19

22

76571_

1,6573

16576

16579

15595

76sg7



16601 Reddy Sekhar Beeragounivari3l
32 76602 Rohith Meduru

J5 Sai Nikhil Uppata
1_

34 16604 Sakthivelu Mannavedu

35 15605 Sireesha Madamanchi

36 16506 Siva.M

1.6607 Soma Sekhar yarlapalli

16508 Sreeharsha Gajula

39 16609 Sreekanth Koneru

40 16610 Suresh Naik Jarpala

4t 1,661,1 Vema Reddy.V
I

42 16612 Venkata Prasad Lekkala

+J 16613 Venkata Rami Reddy Dhanireddy

44 t66L4 Vijayakrishna Bathini

45 16615 Vinay Sudarsi

46

47 Bala Subramanyamachari peddapalem

48 1,6487 Baby Madderi

49 15488 Balaji Mallaram

50 Chaitha nya Na ik Bukke
I5l 16490 Chandana Thyagadurgam

52 16491 Chenna kesavulu Abba L *)
53 1.6492 Damodar.V

54 16493 Dinesh Kathi

16494 Hareesh Gundlapalli
1

56 16495 Kishore Dhuli

57 L6496 Manohar Ragipati

1,6497 Munendra Podili

59 1,6498 Murali Mora
A

60 16499 Nagabhushana Charagaboina rtd

I.IEA

15603

uL
I

37
?

38 Ltt-
L.

Qe t

4L

Bharath Kumar Va llived u

v2-
16485

16486

ut" I

I

16489

\.tk

q6,

50
55 trq

(+ (-,
I

I
58

DEPARTIITTNI OF COMPUTTR SC'iiii'
S.G.S. ARTS COLLEGT;

TIRUPATI



NOTICE

SGSAC/Dept.of Computer Science/HOD/Certificate Course./2018-19

All the Second Year B.Sc MPCS, MSCS, MPC(EM & TM), MPS of Batch 1 and

Batch 2 enrolled students of Certificate Course in MS-Office are hereby informed that the Final

Examination will be held on I 5-02-2019.

Date: I l -02-201 9 HOD

HEAD
DEPAIilIEI{I OT (OMPI'ITR SCITHCI

S.G.S. ABTS COLLEGE
TIRUPATI



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE
CERTIFICATE COURSE IN "MS-Office,'

Batch I & 2
ACADEMIC YEAR:2018-19

Final Examination
Max Marks: 50 Duration: 2 Hours

Name of the Student :

MUITIPLE CHOICE QUESTIONS EACH QUESTION CARRY 2 MARKS

l. Right clicking on something in word

n. Delete the object
B. Nothing the right mouse buton is there for left handed people
c. Opens the short-cut list
D, lnsert the picture

2.We can create the new shortcut kev from

A. Options from Tools menu
B. Customize from Tools menu
c. Properties from File menu
D. Auto Conect from Toolbars menu

3.The autocorrect tool

A. Provides statistics about your document
e. Displays words with the same or similar meaning
c. Checks the grammar in the document
o. Checks for misspelled words as you type and correct them as defined

4'which key or key combination will move the insertion point to the bottom of your document?

A. ctrl+End
B. PageDown
c. Ctrl+Home
o. End

5.To display hyperlink fields in a Word document, you can press the

A. Ctrl+Shift+Fg key
B. shift + F9
c. Ctrl+Alt key
o. None of above
6. To center worksheet titles across a range ofcells, you must
a. Select the cells containing the title text plus the range over which the title text is to be centered
b. Widen the columns

7



c. Select the cells containing the title text plus the range over which
the title text is to be enfettered
d. Format the cells with the comma style

7. How do you delete a column?
a. Select the column heading you want to delete and select the Delete Row button on the

standard toolbar
b. Select the column heading you want to delete and select Insert Delete from the menu
c. Select the row heading you want to delete and select Edit>Delete from the menu
d. Right click the column heading you want to delete and select delete from the shortcut menu

8. How can you find specific information in a list?
a. Select Tools > Finder from the menu
b. Click the Find button on the standard toolbar
c. Select Insert > Find from the menu
d. Select Data > Form from the menu to open the Data Form dialog box and click the Criteria

button

9. When integrating word and excel, word is usually the
a. Server
u. Destination
c. Client
o. Both b and c

10. When a label is too long to fit within a worksheet cell, you typically must
a. Shorten the label
b. Increase the column width
c. Decrease the column width
a. Adjust the row height

I l.When you have completely finished working with a document you should

A. Close it
B. Save it
c. Type it
D. Edit it

12. To cut or copy text you must first

A. Click the remove/duplicate button
B. First highlight the text and click the Copy or Cut command from edit menu
c. Click on File menu
o. None of above
13. How many items can you copy to the OfIice Clipboard

^.248.20
c. 12

D. l0
2



l4.The command cross reference is available in

n. View menu
B. Format menu
c. Insert menu
o. Tools menu

l5.We can send the word documents to

L Microsoft PowerPoint
s. Microsoft Excel
c. Microsoft Access
o. All of above

t6. Which of the following are types of sound files?

a. LOG files

o. DAT files

c. WAV files

o. DRV files

17. which of the following can you use to add times to the slides in a presentation? a. Microsoft
graph

u. Microsoft Table

c. Microsoft Excel

a. Microsoft Word

18. Which view in PowerPoint can be used to enter speaker comments? a. Normal
u. Slide show

c. Slide sorter

d. Notes page view

19. The best way to insert a new slide in a presentation is to use the

a. Normal view

o. Special view

c. Slide show view

a. Slide sorter view

3



20. Which is the best view for getting your thoughts for a presentation out on the computer? a.
Outline view
u. Notes page view

c. Slide sorter view

o. Slide view

2l . The default page orientation of word document is

a. Landscape
B. Portrait
c. Long sides
o. Double long side

22. Y ou can print the documents

l. Print icon from Standard toolbar
B. Print command from File menu
c. Ctrl+P
o. All ofthe above

23. The thesaurus tool

a. Finds repeated words in document
g. Check for synonyms and antonyms
c. Identifies words with capitalization problems
o. All ofthe above

24. To view smaller text on the screen you can

A. Decrease the font points
B. Decrease the zoom percentage
c. Increase the view percentage
D. Increase the editing percentage

25. Which of the following is not option for changing the case of the text?

A. lndent case

B. Sentence case
c. Toggle case
D. Lower case

HEAD

*3[gl'^H'!sHtil;
TIRUPATI

4

******All the Bestl.{i{r***



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMPUTER APPLICATIONS

CERTIFICATE COURSE IN''MS.OFFICE''
Batch I & 2

ACADEMIC YEAR: 2018-19
Final Examination Answer Key

Max Marks: 50 Duration: 2 Hours

QUESTION
NO.

ANSWER

1 C

2 B

D

4 A

5 l)

5 A

7 D

8 D

9 D

10 B

It A

72 B

13 A

t4 C

15 A

15 C

t7 A

18 D

19 D

20 A

2t B

22 D

23 B

24 B

25 A

}!EAD
lllEl'll oF Colltri,Tri --,-.- _-
.s. ARTS coli.' i

TIRUPATI

DTPARI

s.c

3



DEPARTMENT OF COMPUTER SCIENC
CERTIFICATE COURSE IN MS-Office

Academic Year: 201 -2019

17 Jan 2019 to ll Feb 2019

iiEAD
DtPARiMttiI or cofiPUIIR SC|{N'--s.c.s. A c

HO

BT: B.Triveni
DCK: D.Chaitanya Kumar

DAY/TIME THEORY PRACTICAL

8.00 - 9.00 AM 4.00 - 5.00 PM

MONDAY BT DCK

TUESDAY DCK BT

WEDNESDAY BT DCK

THURSDAY DCK BT

FRIDAY BT DCK

SATURDAY DCK BT

BATCH I: TIME TABLE



S.G.S.ARTS COLLEGE, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE

CERTIFICATE COURSE rN MS-Office
A dem ic Year: 20 r8 -20 t9

BATCH 1: TIMETABLE

l7 Jan 2019 to l1 Feb 20t9

DAY/TIME THEORY PRACTICAL

,{.00 - s,00 PM 8.00 - 9.00 AM

MONDAY NJ DCK
TUESDAY DCK NJ
WEDNESDAY NJ DCK
THURSDAY DCK NJ
FRIDAY \J DCK
SATURDAY DCK NJ

H

NJ : N.Jayalakshmi
DCK: D.Chaitanya Kumar

DtpAflIirr.. 
I.itli'''

S.G.S. liii.Is iC
TIRUPATI

LLEGE



Module 1: Text Basics, Text Formatting and saving file, Working with Objects

. Typing the text, Alignment oftext

. Editing Text: Cut, Copy, paste, Select All, Clear

. Find & Replace

. New, Open, Close, Save, Save As

. Formatting Text: Font Size, Font Style

. Font Colour, Use the Bold, Italic, and Underline

. Change the Text Case

. Line spacing, paragraph spacing

. Shading text and paragraph

. Working with Tabs and Indents

. Shapes, Clipart and picture, Word Art, Smart Art

. Columns and Orderings - To Add Columns to a Document

. Change the Order ofObjects

. Page Number, Date & Time

. Inserting Text boxes

. Inserting Word art

. Inserting symbols

. Inserting Chart

Module 2: Header & Footers, Working with bullets and numbered lists

. Inserting custom Header and Footer. tnserting objects in the header and flooter. Add section break to a document. Multilevel numbering and Bulleting. L reatlnS Ltst. Customizine List stvle. Page bordedu "
. Page backgrou-=nd

Module 3: Tables, Styles and Content

: f#iy$f"if} rables, rable Formatting

. Alignmeht ontion. Merge and silit ootion. Qsing Build: in Stytes, Modi&ine Stvles. creatrn& Styles. Creating a lisi srlle -. t qble ofcontents and relerences. Adding intemal references. Adding a Footnote

S.G.S.ARTS COLLEGE, TIRUPATI
DEPARTMENT OF COMPUTER SCIENCE

CERTIFICATE COURSE IN MS-Office

Course Contents

Theorv (20 Hours)

MS WORD



. Adding Endnote

Module 4: Merging Documents

MS EXCE L

Module 6: Introduction to Excel, Formatting excel work book:

. Typing new address Iist. !4porting address list from Excel file. Write anil insert field. Merging with outlook contact. Preview Result. Mergins to envelooes. MerEinE to label '

. Settine -rules for merses. Finish? Merge optiSns

Module 5: Proofing the document, printing

. Check Spelling As You Type.. Mark Cr'ammi Errors As'Vou Type.. Setting Autoconect Options

. Page Setup, Setting margins

. Print Preview, Print

. Introduction to Excel interface. Understand.ing rows and columns, Namins Cells. l orkrng with excel workbook and sheets-. ryew. Open, Close, Save, Save As. f'ormatling Text: Font Size, Font Swle. tont Color. Use the Bold, Italic, and Underline. wrap text. Merge and Centre. !.uqg!Cy. Accounting and other formats. Modrtyrng Columns, Rows & Cells

Module 7: Perform Calculations with Functions

. Creating Simple Formulas. Settlng up your own formula. Date and Time Functions, Financial Functions. Logtcal lunctions, Lookup and Reference. t unctions Mathematical Functions. Statistical Functions, Text Functions.

Module 8: Sort and Filter Data with Excel

. Sort and filterins data. Using number fiiter. Text filter. Custom filterinp. Removing filteis from columns. Conditional formafting

Module 9: Create Effective Charts to present Data Visually

. lnserting Column, pie chart elc.. Create an effective chart with Chart Tool. ?qrign. Format, and Layout options 
- - - '

. Adding chart title



. Changins lavouts. Chart-stv'les'. Editing Lhart data ranse. Editins data series. Changing chart

Module 10: Proofing and printing

. Page setup. Setting print area, print titles. tnsertlng custom Header and Footer. lnserting objects in the header and footer. 
Iag9 .S9tup., Setting_ margins, print preview, print. EnaDle Dack ground error checking. Setttng AutoCorrect Oplions

MS POWERPOINT

Module 1l: Setting Up powerpoint Environment:

. N.ry, Open, Close, Save, SaveAs. lyprng the text, Alignment of texr. rormattlng lext: Font Size, Font Style. Font Color, Use the Bold, Italic, and Underline

: F,Xh ?RI,,.,iTe, 
Serect A I r, crlar Gx1"-- 

""'-

. Working with Tabs and Indenrs

Module 12: Creating slides and applying themes

. Inserting new slide. Changing layout of slides. Duplicatins Slides. loiryipg ai'd pasrins slide. 
ApplylnC themes to. rhe slide layour. L'hanqlnq theme color. Slidebaikeround. Formattin{slide background. ustng sllde views

Module 13: Working with bulets and numbering

. 
Y-lL,lj:y.J.rr.bering and Builering. Lrealme Lrst. Page bo-rderins. Page backgrotind. Ahsnins text. Tex-t dirEctions. Columns option

Module 14: Working with Objects

. 
lfapes, Clipart. and ,picture, Word Art, Smart Art. C hange the Order olobiects. lnserting slide header arid footer. lnserting Text boxes

: iil::XifiE 
shapes, using quick sryles

. InsertinE svmbols. Insertin[ Chart



Module l5: Hyperlinks and Action Buttons

. Inserting Hyperlinks and Action Buttons. Edit Hyperlinks and Action Button. Word Art and Shapes

Module 16: Working With Movies and Sounds

. Inserting Movie From a Computer File. Inserting Audio file. Sy$io Video play.back and format oprions. vtdeo options, Adiust oDtions. Reshapihg and bo;derinb Video

Module l7: Using SmartArt and Tables

. Ygtkilg with Tables. Table Formatring. Table Stvles. Alisnment ootion. {eige and silit option. L onvertlng text to smart art

Module l8: Animation and Slide Transition

. Default Animation, Custom Animation. Modifo a Default or Cusrom Animation. Reorder Animation Usins Transitions. Apply a SIide Transirion:Modifuins a. Transition. Advancing to the Ne-xt Slide

Module 19: Using slide Master

. Usine slide master. Inseri'ine lavout ontion. Creatini cultom lhvout. lnsertinE place holders. Formatting place holders
Module 20: Slide show option

. Start slide show. Start show from the current slide. Rehearse timinp. Creating custori slide show. Qhegk Spelling As You Type. Settlng AutoCorrect Options. Save as video. Save as JPEG files. Save as PowerPoint Show file. Print Preview, Print

HEAD
D[f,fXI/]ltM of co,[PUJtR 5(,r,,

s.G.s. LLEG.



Practical (20 Hrs): Based upon above content

Duration of the Course: 40 Hours

Theory :20 Hours

Practical : 20 Hours

Eligibility

Intake

Head of the Department

Course Mentors

II Year BSc MPCS, MSCS, MpC, MpS Groups

50 Students /Batch

Sri P.Udaya

Smt B.Triveni
Smt N.Jayalakshmi

Sri D.Chaithanya Kumar

r,rflipil{i!'rr I . ':ti'l(i:
S.G.S. A-fi i: "'') --;'tiE

TIRUPi\TI

1

2

J



S G S ARTS COI.LEGE, TIRUPATI

DEPARTMENT OF COMPUTER SCIENCE

CERTIFICATE COURSE IN MS-OFFICE

Academic year : 2018-19

REPORT OF THE COURSE:

1. Name of the Course

2. Name ofthe Course Coordinator

3. No of Students Admitted

4. Faculty Members

7. Percentage of Results

8. Date of Theory Examination

9. Name of the Examiner

10. Date of Declaration of Results

: MS-OFFICE

: P Udaya

: 100 (50 per batch)

:03

: TOOYo

: 15-02-2019

: B.Triveni, N.Jayalakshmi

: L6-O2-2O19

.HE,.\D

lll 6f ComPuTm:-

5. Number of Students Appeared for Exam : Batch l: OO

Batch ll :60

6. Number of Students Passed Batch l:60

Batch ll : 60

q

s.No Name of the Teacher Paper

No of Hours (Classes) Engaged

Theory
Problem Solving /
Practicles

1 Smt. B.Triveni 6 6

2 Smt. N.Jayalakshmi 6 6

3 Sri D.Chaithanya Kumar I
8 8

HoD

+
T

S COLTIIGE

I

I



LIST OF STUDENTS COMPTETING THE COURSE:

5 G S ARTS COLLEGE, TIRUPATI

DEPARTMENT OF COMPUTER SCIENCE

CERTIFICATE COURSE IN MS-OFFICE

Academic year : 2018-19

BATCH - 1

S.No Name of the Student Roll No

1 Anjan Kumar Pottiramigalla II B.Sc. (MPCS) EM 17491

2 Arjun Karli II B.Sc. (MPCS) EM 17492
3 Ashok Kanimeni II B.Sc. (MPCS) EM 't7493

4 Il B.Sc. (MPCS) EM 17 494

5 Bhargav Embeti II B.Sc. (MPCS) EM 17495

6 Brahmaiah Sandu II B.Sc. (MPCS) EM 17496

7 Il B.Sc. (MPCS) EM 17497

8 Harshavardhan Sadda II B.Sc. (MPCS) EM 17498
9 Hrma Vamsi.P Il B.Sc. (MPCS) EM 17499

l0 II B.Sc. (MPCS) EM '17500

lt Jyothsna Kondru II B.Sc. (MPCS) EM 17501

t2 Kartheek Kumar Reddy.D ll B.Sc. (MPCS) EM 17502

t3 Lokesh Kommala II B.Sc. (MPCS) EM 17503

t4 Ivladhu undela ll B.Sc. (MPCS) EM

l5 Mahesh Avisineni II B.Sc. (MPCS) EM 17505

l6 Manohar Bandari ll B.Sc. (MPCS) EM

t7 Manoj Kumar Reddy Beemireddy II B.Sc. (MPCS) EM 17507

l8 Mohana Krishna Bandaram Il B.Sc. (MPCS) EM 17508

l9 Mohini lrri II B.Sc. (MPCS) EM 17509

20 Om Prakash Aaramadaka Il B.Sc. (MPCS) EM

2t Pavan Kumar Anderi ll B.Sc. (MPCS) EM 17511

22 Pavan Kumar Guttapalli Il B.Sc. (MPCS) EM 17512
23 Prabhakar Badikela II B.Sc. (MPCS) EM 17513
1,1

Praneeth Kumar Uppuluru II B.Sc. (MPCS) EM 17514

25 Prasanth Muppuri II B.Sc. (MPCS) EM 17515

Class

Bharath Kumar Reddy Kamireddy

Devarabetta Thimmaguru

Joseph Merugumolu

17504

17506

17510



Roll NoS.No Name of thc Student

17516lI B.Sc. (MPCS) EM26 Rajesh Akasam

17517II B.Sc. (MPCS) EM27 Ram Prasad Korlakunta

II B.Sc. (MPCS) EM 17518Ravali Baduru

17519II B.Sc. (MPCS) EM29 Ravi Durga Prasad Donti

17520II B.Sc. (MPCS) EM30 Ravi Teja Mekala

17521II B.Sc. (MPCS) EM3l Sai Prakash Penchili

17522Il B.Sc. (MPCS) EM32 Satish Veligiram
Il B.Sc. (MPCS) EM33

II B.Sc. (MPCS) EM34 Sravani Pidugu

17525II B.Sc. (MPCS) EM35

17526II B.Sc. (MPCS) EMJO Surekha Pulluru

17527Il B.Sc. (MPCS) EM37 Suri Babu Motikala

ll B.Sc. (MPCS) EM 17528Tejaswini Manyam38

17529Il B.Sc. (MPCS) EM39 Thulasi Babu Ardhamala

17530II B.Sc. (MPCS) EMUmapathi Pamula

17425II B.Sc. (MPC) TM41 Ajith Kumar

17426II B.Sc. (MPC) TM42 Chandra Mouli Degala

17427II B.Sc. (MPC) TM43 Gunasekhar Reddyvari

17428II B.Sc. (MPC) TMHemanthkumar Yanadannagari44

17429ll B.Sc. (MPC) TM45 Mahesh Babu Vakiti

17430Il B.Sc. (MPC) TM46 Mahesh Madhavaram

II B.Sc. (MPC) TM47 Nagaraju Pothina

17432II B.Sc. (MPC) TMNageswara Velpula48

17433Il B.Sc. (MPC) TM49 Pavan Kalyan Naik Vaditiya

17456Il B.Sc. (MPC) EM50 Chakradhar Vyas Bola

17457II B.Sc. (MPC) EM5l Chandu Karnamkota

17458II B.Sc. (MPC) EM52 Chiranjeevi Tankam

17460Il B.Sc. (MPC) EM53

17461II B.Sc. (MPC) EM54 Gnanasekhar Chittathoor

17462II B.Sc. (MPC) EM55

17463II B.Sc. (MPC) EM56 Hari Prasad Byrisetty

t{AF/fn,,",ll B.Sc. (MPC) EM57 HEMANATH.POOJARIS

1E4Ss. III B.Sc. (MPC) EMJagadeesan A.K

17466 1II B.Sc. (MPC) EM59 Mahesh Pasapala

17467II B.Sc. (MPC) EM60 Mahesh Ravula

HEAD
Of COfiPUI

co
T[ SCIFI.'CII -l-l.l

Class

28

17523Shaik Adam Basha

17524

Sreekanth Chejarla

40

17431

Ganesh Mandadhi

Hanumanthu Yerukala

58

TI



BATCH - 2

S.No Name of the Student Class

I Allipeera Dudekula ll B.Sc. (MSCS) EM 17541

2 Anjali Bodannagari ll B.Sc. (MSCS) EM 17542

Anjineyulu Vijayanagaram II B.Sc. (MSCS) EM 17543

4 Anusha Minuku ll B.Sc. (MSCS) EM 17544

Bhuvanesh Ragam 17545

6 Chalapathi Arava II B.Sc. (MSCS) EM 17546

7 II B.Sc. (MSCS) EM 17547

8 Deva.G 17548

9 Dharani Kuamr. M Il B.Sc. (MSCS) EM 17549

l0 Ganesh Kumar Gujjala II B.Sc. (MSCS) EM 17550

Hemanth Mekala II B.Sc. (MSCS) EM 17551

t2 Himavanth Sanambatla II B.Sc. (MSCS) EM 17552

l3 Jagadeswari Sakam II B.Sc. (MSCS) EM 17553

t4 Kiran Kumar Chakali II B.Sc. (MSCS) EM 17554

l5 Lokesh Chitteni II B.Sc. (MSCS) EM 17555

l6 Lokesh Pasupuleti Il B.Sc. (MSCS) EM 17556

t7 Loknath Upendram ll B.Sc. (MSCS) EM 17557

l8 Madhu Peta II B.Sc. (MSCS) EM 17558

l9 Manikanta Balagani II B.Sc. (MSCS) EM

20 Meghana Maddela ll B.Sc. (MSCS) EM 17560

2t Muni Sai Kumar Ponna ll B.Sc. (MSCS) EM

22 Narsappa Pandikona Il B.Sc. (MSCS) EM 17562

23 Raja Dhannasi Il B.Sc. (MSCS) EM

24 Raju Singadi II B.Sc. (MSCS) EM 17564

25 Rethish Sai.JM II B.Sc. (MSCS) EM 17565

Rupesh Kanakappagari II B.Sc. (MSCS) EM 17566

27 Sai Kumar Anthati II B.Sc. (MSCS) EM 17567

28 Sai Kumar Kesani 17568

29 Sai Kumar.U II B.Sc. (MSCS) EM 17569

30 Sandeep Chakram II B.Sc. (MSCS) EM 17570

3l Santhosh Kumar Kantineni II B.Sc. (MSCS) EM 17 571

32 Sasidhar Nagella 17572

33 Sathish Kumar Gurrappagari II B.Sc. (MSCS) EM 17573

Roll No

3

5 II B.Sc. (MSCS) EM

Chandra Sekhar Nama

II B.Sc. (MSCS) EM

l1

17559

17561

17563

26

ll B.Sc. (MSCS) EM

II B.Sc. (MSCS) EM



S.No Name of the Student Class Roll No

34 Srinivasulu Bapana II B.Sc. (MSCS) EM 17574

Sumalatha B II B.Sc. (MSCS) EM 17575
36 Sunil Pasupula II B.Sc. (MSCS) EM 17576
37 Supriya Didi II B.Sc. (MSCS) EM 17577

38 Suresh Gonimadathala II B.Sc. (MSCS) EM 17578
39 Surya Guggilla II B.Sc. (MSCS) EM 17579
40 Vamsi Krishna Ghattamaneni Il B.Sc. (MSCS) EM 17580

4l Vara Prasad Sige II B.Sc. (MSCS) EM 17581

42 Venkatesu Appannagari II B.Sc. (MSCS) EM 17582
43 Venkatramana Vijayanagaram II B.Sc. (MSCS) EM 17583

44 Venugopal Putakala II B.Sc. (MSCS) EM 17584

45 Vinay Jadapalli II B.Sc. (MSCS) EM 17585

46 II B.Sc. (MSCS) EM '17586

47 Yeswanth Gownipalli II B.Sc. (MSCS) EM

48 Yuvaraju.S Il B.Sc. (MSCS) EM 17588

49 Il B.Sc. (MPS) TM 17595

50 Chandrudu Jadipi ll B.Sc. (MPS) TM 17596

5l Gurunadh Sammeta ll B.Sc. (MPS) TM 17597

52 Jayakumar Obulapuram II B.Sc. (MPS) TM 17598

53 Raja Mohan Boddu Boina II B.Sc. (MPS) TM 17599

54 II B.Sc. (MPS) TM 17600

55 Rakesh Paramaala II B.Sc. (MPS) TM 17601

56 Sai Kumar Bommala ll B.Sc. (MPS) TM 17602

57 Vasu Bandla Il B.Sc. (MPS) TM 17603

58 Viswanath Burru II B.Sc. (MPS) TM 17604

59 Sreekanth Oduguru II B.Sc. (MPC) EM 17483

60 Vinodh Kumar Pandigunta II B.Sc. (MPC) EM 17445

HEAD
DEfLniiltU{I 0i cailtpuTtR 5(lIr,. r

S.G.S. ARTS .CLLE(I
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inator

35

Vishnu Vardhan Mamuduru

17587

Ashok Kumar Kuchapu

Rakesh Bonasi



CERTIFICATE OF COURSE COMPLETION 

This is to certify that Mr/Kum. ____________________________, ______________

group, has attended the certificate course in ______________________________________

OM NAMO VENKATESAYA     

TIRUMALA TIRUPATI  DEVASTHANAMS 

S.G.S ARTS COLLEGE:TIRUPATI          

conducted by the department of __________________________ from ____________to

____________. He/She has successfully completed the course and fulfilled all the

requirements for the award of the certificate in _____________________________.

Course Coordinator  PRINCIPAL 
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Permission Letter
SGSAC/Deot.of Commerce/HOD/Certifi cate Course/20 I 8- I 9

Fronr Date: 23/Jul/2018.

HOD.
Department of Commerce,
S.G.S Arts College,
Tirupati.

To

The Principal,

S.G.S Arts College,

Tirupati.

Respected Sir,

Sub: Requesting for permission to conduct Certificate Course in p!!y - Regarding.

We have planned to conduct a forty hours Certificate Course in !g!\ for Three batches of Final

Year students from 0l/Aug20l8 to 21lAugDll\. Therefore kindly permit us to conduct this Certificate

Course.

Thanking Yot1 Y

H

?'ffI{,,,:U--:i'J

llv,





It is to inform to all the Final Year students that we are going to conduct a Certificate

Course. The details ofthe course offered are as follows.

Students who are interested to join the course can contact the Coordinator of Certiflcate

Course Dr.Y.Mallikarjuna Rao for further details of course content, study material and

prerequisites of the course.

Course Coord inator

;riAl"r

r"{iil$":lFirs:i;

Course name Tallv

Course date & duration 0l/Ar;'!2018 to 27lAug/201 8: 40 Hours

Timings Batch I :

Theory: 9:004'M to l0:00AM
Practical:4:00 PM to 5:00 PM

Batch 2:
Practical: 9:00AM to l0:00AM
Theory:4:00 PM to 5:00 PM

Batch 3:
Theory: 8:00 AM to 9:00 AM
Practical: 5:00 PM to 6:00 PN4

Course Mentors Batch l: Dr.G.Manjula
Batch 2: Dr. T.L Narasinrha Reddy
Batch 3: Dr. P.Madhusudhana Rao

NOTICE

SGSAC/Dept.of Commerce/HOD/Certifi cate Course/20 I 8- I 9



Details of the Course

Name of the Certificate Course

Batch

Timing

No. of students/ Dept/Year/ Course Duration:

Venue :

Pre-requisite

Eligible Groups

Trainers

Certificate

Course Coordinator

Tally

I

Theory: 9:00 to l0:00 AM

Practical: 4:00 to 5:00 PM

50/ Commerce/ 20 I 8- I 9/ 40 Hours

Theory: Room No 306

Practical: Commerce Lab

Basic accounting and clear rules ofaccounts

Ill Year BConr all Groups, BA (ASCA)

Dr. G.Manjula

Internal

Dr. Y.Mallikarjuna Rao

it i,

oaprrtment of t)omm6r.-c
'i G.S. Arts Colleq6 11 1g

' .)r,l'^rr. -,n.
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Details of the Course

Name of the Certificate Course

Batch

Timing

No. ofstudents/ Dept/Year/ Course Duration:

Venue :

Pre-req u is ite

Eligible Groups

Trainers

Certificate

Course Coordinator

Tally

2

Practical: 9:00 to l0:00 AM

Theory: 4:00 to 5:00 PM

50/ Commerce/ 20 I 8- I 9/ 40 Hours

Theory: Room No 307

Practical: Commerce Lab

Basic accounting and clear rules ofaccounts

III Year BCom all Groups, BA (ASCA)

Dr. T.L Narasimha Reddy

Internal

Dr. Y.Mallikarjuna Rao

olpertlt}tnt ol Comrvrar,-a
.i G,S. A rrs C^lleoe i f t.D

! ,r?tj pA i r -r - 5O.r



Details of the Course

Name of the Certificate Course

Batch

Timing

No. of students/ Dept/Year/ Course Duration:

Venue :

Pre-requisite

Eligibte Groups

Trainers

Certificate

Course Coordinator

Tally

J

Theory: 8:00 to 9:00 AM

Practical: 5:00 to 6:00 PM

50/ Commerce/ 20 I 8- I 9/ 40 Hours

Theory: Room No 308

Practical: Commerce Lab

Basic accounting and cleal rLlles ofaccounts

Ill Year BCom all Groups. BA (ASCA)

Dr. P.Madhusudhana Rao

Intemal

Dr. Y.Mallikarjuna Rao

A
clcPirtncnt ot
.i G,9. Arts College (Y.Y.D

"} iQtjtrAl, -E ' -)n,?

r:



S.G.S.ARTS COLLEGE, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY
Academic Year: 2018 -2019

BATCH I: TIME TABLE

0l Aug 2018 to 27 Aug 2018

OD

GM: Dr. G.Manjula lr'r:AIr.

$:JTi$:ii,,, irid

DAY/TIME THEoIIY PRACTICAL

9.00 - 10.00 AM 4.00 - 5.00 PM

MONDAY GM GM

TUESDAY GN,I GM

WEDNESDAY G]\,I GN{

THURSDAY GM GM

FIIIDAY GM GM

SATUITDAY GM GNiI



S.G.S.ARTS COLLEGE, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY
Academic Year: 2018 -2019

BATCH 2: TIME TABLE

01 Aug 2018 to 27 Aug 2018

NR: Dr. T.L Narasimha Reddy

ot)

HEAU
aatrrtmcnt ot CDmmer,!,r

'i G.. . Arts Colluge lT.T.D
r!*U PAI l -e - 'in '

DAY/TIME PRACTICAL TIItrOITY

9.00 - 10.00 AM 4.00 - 5.00 PM

MONDAY NR NII

TUf,SDAY NR NIT

WEDNESDAY NR NR

TTIUR,SDAY NR Nt{

FRIDAY NR NR

S-4.TURDAY NR NR



S.G.S.ARTS COLLEGE, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY
Academic Year: 20I8 -2019

BATCH 3: TIME TABLE

0l Aug 2018 to 27 Aug 2018

DAY/TIME THEOIIY PRACTICAL

8.00 - 9.00 AM 5.00 - 6:00 I'N'l

MONDAY PM PM

TUESDAY PN,I Plt
WEDNESDAY PM PM

THURSDAY PM PM

FRIDAY PM PNI

SATURDAY PM PM

l)

PM: Dr. P.Madhusudhana Rao



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE
IIIiOR 9:00 AM to l0:00 AM
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Roll No
Name of the

Student

t l I I 6- / I l I t I I II 16001 Akhil Syed I I
/ I *- I I I I t t I t I I I2 16002 Anusha Nalathoti

I I I I I o- I (L I I I3 16003 Bhanu Prasad Kothipaka

I / I I I I I I I t4 16004 Chamindeswari Viswanadham I
I G- I I I I I I I & I I5 16005 Dhanam.j aya Gundekayala

o_ I I I t I I I / I I I6 16006 Dinesh Kanaparthi

I / (L I I I t o.- I , I7 16007 Gayathri Kavali I
I I I o- I I8 16008 Guru Prasad Ramanaboina I I I & I I I

Kiran Kumar.S I I I ( t / I a- I I I I I I II 16009

Koteswar Aduri I I I o- I I o-
,I

Il0 I 6010

I I I I I I I I I I I Il60l I Leela Krishna aturu

6- t
,l

I I I G I t I It2 16012 Madhu Sudana Gumpu I
,t

t
f I t t I I I G.l3 1601 3 d- I I G- I I I I I

Mahesh Chakali I I I 'l o- I I I o.- t I I I I G, t l I I14

I I / I I I I I I I t I
,l I / I I15 l60l 5 Mahesh Konduru

I
,I

I o- I I I160r6 Muni Theja deppagari I I I (L I I I t I I t
INaga Surendra Chinnakatti I I I I I I I I I I I I I t I o-17

I I o* I I a- I I I I t I I I I o- Il8 1601 I Nagarjuna hupakula

I I I Il60l 9 Naresh llhuma I I I I t I I I q- a- I I I
Pavan Kalvan Thoti I I I I I I I I I ( I t I20

I I I I I I I I I I I d- I I G* I2l I 6021 Pradeep Pandeti

I I I A dL- I I16022 Prasad Ilokkarokula I / 6- t I I c,"- /
I 't,t 16023 Prasanna Kumar Kolika I I o- e I o- I I I A. 7 I

orRajasree Sodem I I I I I I I I I I t / (t\)4
16025 Ramesh Koneti G- t I I I I I I I o' I I I I I (\ I I It)

I (1- I o- I I I I / I I I o* ( ('r--26 16026 Rar.nesh Pallapu

O. I I I I I I27 16027 Ramesh Tatipatri I I I I I I G- I o- I

STUDENTS ATTENDANCE LIST BATCH I

S.No
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16020
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t6024



S.No Roll No
Name of the

Student
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28 16028 Revathi Chennampalli I I o- t t ( t t I I I I
29 ( I d* I I I (
30 1603 0 Sekhar Akkupalli I

,/
I I o* It

16031 Shabeena Syed I I G I
32 Sandhya Surakani I & t G.* o- I
33 16033 Siva Kumar Thupili dr I t I o-
34 16034 Soniya Narayanavanam t I G. (
35 16035 Sravan Kumar Bedapalli t I I 7 '\/ d\ .L I f
36 16036 Subramanyam Kattamanchi I I I 6. n- I I
37 16037 Surendra Thati I rL I I t I

1603 8 Surendra Tupakula I I / o._ ct'- c
39 16039 Vamsi Krishna Cherukuri I I t I 6- I I
40 16040 Vasanth Kumar Naik I 11- I I I G- I

I

I
4l 16041 Veeresh Mukarangappagari I I I I d.- I 6.- I
4). 16042 Venkatesh Kandappagari t t I I I I (\, I ( 1

4-t 16043 Venkatesh Katta I I I I o- I a. I I I I
44 16044 Venkatesh Kukka G- ( I I a I I / I I
45 Venkatesh Nidiginti I I I I d\,
46 16046 Venkateswarlu Guggila I I at.- I I I
47 16047 Venkateswarlu Nagam t I I I I ( (

48 Vinay Mogilireku I I I I I I I .L ( I
49 16049 Vinecth Suddarasi I 6. I G.

,l o- I I
50 16050 Yadhagiri.R I I I I I o*

A

C)all ment ot
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16029 Sachin.S

3r
16032

38

16045

16048



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY"
STUDENTS ATTENDANCE LIST BATCH 1 PRACTICAL 4:00 PM to 5:00 PM
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
S'fUDENTS ATTENDANCE LIST BATCH 2 PRACTICAL 9:00 AM to l0:00 AM
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
STUDENTS ATTENDANCE LIST BATCH 2 HE()IT ,l:00 PM to 5:00 PM
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY"
STUDENTS ATTENDANCE LIST BATCH 3 HI,tOIt 8:00 AM to 9:00 AM
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SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
STUDENTS ATTENDANCE LIST BATCH 3 RACTICAL 5:00 PM to 6:00 PM
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16199 Nagarj una Palaparthi I I I t I t I26 G- I I I
I / I I27 16201 Prasanth Gurram I I

I 7 I I I28 16203 Priya Nagamoodu 4- t I
29 16204 Purushotham Nellori G- I t I I I

Sugnanam Harijana i, d* a- I30 16213 a_ ( -r- I I o-
I a- I31 16214 Sumanth Annameti a- I I

32 Sumanth Mudra o* I (\
Vasu Siripireddy I I tu I I162t8 o- I I

/ t I34 16220 Yaswanth Kumar Yallankila d- o- I I c_
I (\35 16221 Ashok Manam I I I t I

t6222 Balakrishna Ballem t I I I I I ar-36 I I
r6223 Bhanu Prakash.B I

,I
I I I I

Govindarajulu. R I I 616226 I I t I

t
I16227 Guna Sekhar.G.C t /}- I I

40 16228 Harikishna Reddy Korlakunta a- I I / I
41 16229 Hemadri.G I t ,I ,/

o- I I I a-
16234 Mohan Reddy Nalipireddy I i I t42 o- ( t': I

I43 16235 Pavan Kalvan.G ( G- I I
44 t6237 Sanjay Goduguchintha I t t & ( I I

16240 Sathish Naik Vadthiya & I I I45 I I I I N
I46 16241 Sunil Kumar Madduru I I o*- ,/

I I I
47 16242 Suresh Maddeboyena I I I t o- I I

16243 I G- I48 I a-r I I I I
I I I19 t6244 Vamsi Krishna Patlukota I

,I & I a. I
-50 t6245 Veera Badrudu Guvvala I I i t I a- I I I I I I /

,:,reperlm.nt .t Comrr{Uut
. G q r4s L'nlt,,r1e ivff

'1:f A: '.j ' -.r.

Name of the

Student

oo

a.t
oo
O
*

S.No

16215
33

37
38
39

d-

Suresh Pandluru



SCSAC/Dept.of Commerce/HOD/Certifi cate Cou rse/20 I 8- I 9

All the Final Year Batch l, Batch 2 and Batch 3 enrolled students of Certificate Course in

TALLY are hereby informed that the Final Examination will be held on 28-08-2018.

Date: 27-08-2018 OD

XEAT}

:i"s"T::'"":,[3T[1'ii
'"'ltl9A1t't - ':n'

NOTICE



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
STUDENTS TEST ATTENDANCE BATCH I

Date: 28-08-201 8 Timini :4:00 to 5:00 PM

S.No Roll No Name ofthe Student Signature

l I600r Akhil Syed Aklnit s,til,
2 16002 Anusha Nalathoti I 1,, la lf,rr h'-*'n',rA

a
a

16003 Bhanu Prasad Kothipaka B La-nu Dr .'! a ",.l

I 16004 Chamindeswari Viswanadham I" Cl ,n 'cn-lrt ur*r)
5 16005 Dhanamjaya Gundekayala

6 16006 Dinesh Kanaparthi 41,.D}&..re.k-
7 Gavathri Kavali Jr. fr-rS/a-rn'
8 Guru Prasad Ramanaboina C,,n ilr-l .Q
I 16009 .(' &l t a,,,,&t )wre-tKiran Kumar.S

Koteswar Aduri t,t o'*tst^tfit A)uni
ll 16011 Leela Krishna aturu I eela kricA.,a o-h,r,r
t2 16012 Madhu Sudana Gumpu C . uad l,,ur,.
l3 1601 3 Madhu Madduru M'l'^oh^'r
1.1 16014 Mahesh Chakali A- t4a h:rn--
l5 r60ls Mahesh Konduru w ffihril^

l60l 6 Muni Theja deppagari F N u*.r frrro.
t7 l60l 7 Naga Surendra Chinnakatti /, nlJl.|uitilJ/hn-
l8 Nagarj una hupakula I'l . trlo 4 a"rt u tr O
t9 1601 9 Naresh Bhuma A)071Ci,lA Dtlttnt,
20 16020 Pavan Kalyan Thoti ".btlavdD--
21 16021 Pradeep Pandeti ? ^)o"o'foll.n'

16022 Prasad Rokkarokula rtnr'tMt]
23 t6023 Prasanna Kumar Kotika L.D*s.-ii* 'L,, 

^^o$,
21 t6024 Rajasree Sodem { . Q.-3 <r<*oo
25 t6025 Ramesh Koneti r.'P-",1- o ( 

^
ll) 16026 Ramesh Pallapu anwld,h 0rlhnt
27 16027 Ramesh Tatipatri -i,' rli,url/"
28 16028 Revathi Chennampalli P o'-lA' 

" 
t/n.^,.tt-

29 Sachin.S Au)-,in.a
30 16030 Sekhar Akkupalli tui:ita--*r<Komti
3l 1603 t Shabeena Syed a^^;;*n^'
32 16032 Sandhya Surakani 9. Sg-'d0^V ,t
33 16033 Siva Kumar Thupili s,itro uhnfitltii
34 16034 Soniya Narayanavanam t\l CA nr V cl.,
35 16035 Sravan Kumar Bedapalli lP q*.,-,^ ,:T^:

r6036 Subramanvam Kattamanchi k. g ,, -e1oL zr. ..ax

3

16007

16008

l0 16010

t6

160r8

22

16029

36



S.No Roll No Name ofthe Student Signature

37 16037 Surendra Thati -T. ( r,rrr'tJra
38 16038 Surendra Tupakula T.' t u",a*lr4
39 16039 Vamsi Krishna Cherukuri r-. y'arn ti Y,; d"fi"'
40 16040 Vasanth Kumar Naik N. ./ss.^uJ0, b-.nt))
11 1604 I Veeresh Mukarangappagari t{, Y, tp tL
12 t6042 Venkatesh Kandappagari -k a/.-u!*-t
43 t6043 Venkatesh Katta VL."t<-alLbe-;},
-+l 16044 Venkatesh Kukka ki^;;;L
45 16045 Venkatesh Nidiginti hr {onbte6L

16046 Venkateswarlu Guggila e .,la-ttkdA'rav(,*
47 16047 Venkateswarlu Nagam N'Vo-n-&ofi-eat
48 t6048 Vinay Mogilireku Nr, ul vOtLl
r+9 16049 Vineeth Suddarasi S v tn.c tL

t.

50 16050 Yadhagiri.R R. Yadttaq/t,,

H AD
rnmolta

. reFa rtrnant of (-.o
r, iT.T.D

GS ads

46



2
4:00 to 5:0OPM

S

Date: 28-08-2018
Signatlue

tudentSthefoameN
Roll No

S.No uruvK
16081 anJakashrPuhanI}16082 alariTkharheSB16083

anurutlnhandC16085
C ani M inuku

16086

16088 J
16089

PrasadD16090
S

Dur16092 renKan
16093

Geetha
16094 iamPshna
16096 BodiumarKH16097 ,ttl
16099

J a Kri
16100

16101 IvalKaAIeswtheoJ16102
aadhuS \."..-

16104
ikint IPuluesawlK

Kiran
uruannN

16106
Kumar .N.D

16108
Lalitha Bathula

16109

161i0
athuruchiLokes lamh

16111

Madhu Pi
16113

Karra
16114

16115
Cheekolu

16117
Kd

aerakalChshnahanMo16118

16119

Naresh Gudla
16120

Naveen Bo a

Orus

30

16121



S.No Roll No Name of the Student Signature

33 r6122 Naveen Bandla D',0^^ .-.-Q-"*4L
34 16123 Naveen Kathi f*L"--orn +aXh
35 t6124 Naveen Paturu 1lav,oe.,, Po,E -r-v
36 16125 Ninith Kudimi z:../i,t;tA k t,,-limi
37 16126 Pavan Kalyan Vaidyam h-
38 16127 Prabhu.M.J ?.-^Ll^r. M, I
39 16128 Premkumar Malchi ?zen lr-,. ^^^ M alclni
40 16129 Purushotham Bodireddy ?*r,,oln lta^ C(" A;.o Jd,
.+l 16130 Raghu Raman

42 l6l3l
tt

Cv .'Q,.iaLRajesh Gunteti

43 16132 Reddi Sekhar Reddy.Y Y Afur gul"a^
44 16133 Sai Kumar Palamakula O <at4t-"'at'-
45 16t34 Sai Prasad Baddala

46 16135 Satheesh Chandran

16136 Satheesh Kalavakunta

48 t6137 Sathish Kumar.P

49 16138 Siva Peruru )11
50 16139 Sudheer Mallepalli M a*$,",n

rl
nt ol 41,.

,Dorpa
'i G.s' ..1 s Cotleg. (1.1

"rt
r'..Q Lt2a1 ' '

I

Q*e^^.

tn \o>ol-l--4
Crtrw

47 V--t <-"ffi'-tt=
P- Za*l\^Y*\"v$d@w



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
STUDENTS TEST ATTENDANCE BATCH 3

Date: 28-08-2018 Timini : 4:00 to 5:00 PM

S.No Roll No Name of the Student Signature

I l6l6l Anand.M Anr.'A. M
2 16162 Ananda Babu Cheekatipalli (-. A,,-A 

^Jwe-A41"--.-.-.-J 16163 Anil Kumar.E

1 16165 Bhargavi.P (PL-^-, .-t .P
) 16166 Bhaskar.T Rhrr r\< rtgr . 

-T-

6 r6168 Charan Raj Kodi Az1k-.
nn )o+ tc.,-."'*-7 l6t 70 Dileep Kumar Bandi

8 16171 Dinesh Samanthavada L<. Ot--4
o 16t72 Durga Prasad Yadav Podaurla 6-aAy)P - r)r -r'f-t+-
l0 16174 Ganesh Kuncham

,-- I
l--a.,-sJ4,.,

I

l1 fAu-i 41} d"l^.,.
--vT
C-'ta t tat6t7 5 Gavathri Gaddam

t2 t6177 Gurrappa Nachu
-T-t
N )'?-t, "t>-t> oc-."-

l6l 78 Hari Kumar Duddu uJL.--<I

D
t4 16179 Jagadeesh Kamasani L. c^qo)'aL,
l5 l6l8l Jyothiswar Tharigonda -l- rrlt^u ---t
16 16182 Kadiresh Kukati v)LA)L
t7 l6l 84 Karthikeyan.G a. U--^J+^ tz-,i c-.
l8 16185 Kesava.C

I

Lr-^o^,^ c
l9 161 87 Kishore Godugunuru /-" . tz:tLo-tz-
20 16188 Lakshmipathi Bhootannagari -n,'l^t-l-b&
2l M--A,..t; 1"-"J-l6l9l Madasi Hindu

22 16192 Madhu Kanagani '14 rt..t L u .+-.-'^o-^-.---','
23 Madhukar Naik Mude i.iJ[* xt;
24 Markonda Chennappa n)'a. Ma9. Y-ot

25 16197 Sambaiahpalem i ^J-^-t--
-o Nagarjuna Palaparthi lr.\ o o aerirrnn 0Jrail*.
27 t6201 Prasanth Gurram d^ ,,iol^*L'

16203 Priya Nagamoodu P--.,' /\t o^.o arnodJ^-^

29 16204 Purushotham Nellori . w<./tL-c)+Lo.-.-
T

N,
30 16213 Sugnanam Harijana luA '1z--r'--"--tr'tH
31 16214 Sumanth Annameti rA-"^.*H
32 t6215 Sumanth Mudra xz1.41t,^-a.^*l-

l3

16193

16t96

16199

28



S.No Roll No Signature

\ I t-+t *^.tJ-.33 16218 Vasu Siripireddy

34 Yaswanth Kumar Yallankila Y^,i.,J* L,-^^ 9oil^nfl

"4 
il*L M^."^,-r116221 Ashok Manam

36 16222 Balakrishna Ballem f)' a-tr--r.^--f'*"'
37 16223 Bhanu Prakash.B 6{6lLa4 Lfl' &L".,"
38 G-o,;,,-) ^ ^r';r.lu'Q16226 Govindarajulu.R

39 Guna Sekhar.G.C '(4,,,,oe,"r1.,,r.c.z-
40 16228 Harikrishna Reddy Korlakunta k. Hort f,tL^^-044
4t l/le,^^A.-' e. I16229 Hemadri.G

42 t6234 Mohan Reddy Nalipireddy l..t . raako^ O-A),a
43 16235 Pavan Kalyan.G rD--. iJ,n-.t e-
44 16237 U =c-i-.n..-("Sanjay Goduguchintha

16240 Sathish Naik Vadthiya c J-linr'L-, tt-
46 16241 Sunil Kumar Madduru Cv.ri\ lr,^*.'r. Mo,dJ.r.,r
47 Suresh Maddeboyena ttl, (ufUl
48 16243 Suresh Pandluru (.^."-rh PcnnA\.-^r,.r

49 16244 Vamsi Krishna Pattukota P.v^i Y,,q'l"--.-
50 16245 Veera Badrudu Guwala ilI".AJJ c,,"^/^

:B'"T::'"1 Iteg.
tflotl,a
{r.r o

Name of the Student

16220

35

16227

45

16242



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
MARKS SHEET BATCH I

S.No Roll No Name of the Student Marks in Figure Marks in Words

I I 6001 Akhil Syed +o -&lrt.{ mrv
2 16002 Anusha Nalathoti /k2- {...,!, i.,oo
3 16003 Bhanu Prasad Kothipaka A3 4-.,tuJ*lt^voo
4 16004 Viswanadham /L/+ l^,td 4. ,

16005 Dhanamjaya Gundekayala /-o J-,r{, .r^lv
6 Dinesh Kanaparthi 1-9- **'
7 Gayathri Kavali 3q -rl"i,-l.r rcn e
8 16008 Ramanaboina Z* -rr-;- ",t' Pi*{
9 16009 44

:J -\J

-P.r,rtu en\V
t0 Koteswar Aduri /ul

J

-P.,,.tt\u ocp
ll l60l I Leela Krishna aturu h-lL -e-*"t-Atu
t2 16012 N{adhu Sudana Cumpu /.9- -R,"+"+m

16013 N{adhu Madduru 3q
I

-iht.{" cf,ne

t4 16014 N{ahesh Chakali 36 1'.d qil
t5 16015 Mahesh Konduru 3* =r"*{ cral.,t
l6 I 6016 Muni Theja deppagari +t -&.r.,\..1 oo,€
t7 Chinnakatti /r-Z- -h^u'r*.
l8 16018 Nagarjuna hupakula 39 -rh\tkr n'ino

l9 160r9 Naresh Bhuma +3 -G.,.{i -rhrea
20 16020 Pavan Kalyan Thoti Z6 ' t n*'r\l \ .t ,-
2t 16021 Pradeep Pandeti /t-Z A.,utq -t$.r40
22 16022 Prasad Rokkarokula 4-6 -R.*r.isr
23 16023 Prasanna Kumar Kotika +2- -Q.-d +m

16024 Rajasree Sodem 3q -lL\d..r nfrP
25 Ramesh Koneti 3g rr,i*i evru\
26 16026 Ramesh Pallapu LI -f.,..iil *p
21 16027 Ramesh Tatipatri 4+ 4**"{.*v

16028 Revathi Chennampalli 40 3*.*t ^n\v
29 16029 Sachin.S L2- .+*..\i"\.-i
30 16030 Sekhar Akkupalli +l -J

-C^..,.{..t sr€
1603 l Shabeena Sved 'rl:*q eEh\

32 16032 Sandhya Surakani /!-Z- 3**\\ d,:o
33 16033 Siva Kumar Thupili lLZ -Bo<\q -\rrco
34 16034 Soniya Narayanavanam €..rkr.tQ.,rcP
35 | 6035 Sravan Kumar Bedapalli 4o -€c,tr<k-r r*Nl

16036

Subramanyam
Kattamanchi +L- -{--qg"

5

16006

16007

Kiran Kumar.S

l 6010

l3

16017

16025

3l 3*

36



S.No RollNo Name of the Student Marks in Figure Marks in Words

37 t6037 Surendra Thati +o Far, [u on\v
38 r6038 Surendra Tupakula 1t-9 - ;.r.d. {r-oo

39 t6039 Vamsi Krishna Cherukuri 4-o -.6,.rrtt-r oo\Y
40 16040 Vasanth Kumar Naik L\ -P'"''.ti .;
41 I 6041

Veeresh

Mukarangappagari 3q r\i& rrrr€
t6042 Venkatesh Kandappagari +0 f*r(*i orrY
16043 Venkatesh Katta a-l+ -6.*d +^*

14 Venkatesh Kukka 38 . **,.,.t4tAqh{
45 16045 Venkatesh Nidiginti AZ -r-."d-+ir"
40 r 6046 Venkateswarlu Guggila sq -*hi<tq rcne
47 16047 Venkateswarlu Nagam +o -a.,.( o0\/
48 16048 Vinay Mogilireku +2- -(--d-*.-
49 16049 Vineeth Suddarasi +l+ -6..*+,q -L.*
50 Yadhagiri.R L'-Z -lr*,( {{^',"<

U
.nt af (:ommerl,.

e iT.I.o
G.Fi.A ,15 Colle9

rrrn 1 '

43

16044

t6050



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN IITALLY'I

MARKS SHEET BATCH 2

S.No Roll No Name of the Student Marks in Figure Marks in Words

I l 6081 Ayyaswamy Kuruva 39 -Jr^thilftq Ain4
2 16082 Bhanu Prakash Jangam +o -ff^.td.r *tv
J 16083 Bheema Shekhar Talari +l -6.*+J ""e
4 16085 Chandini Avanuru L2- -A..rkr .t oo

5 16086 Chakrapani Minuku /.P3 -4-,,,"tcr -ttwae

6 16088 Deva Varshini.S 3q '-l[.'lVt r mr'e
7 16089 Devendra Kamasani ZB -d"'.d.-t C&rt
8 16090 Dhurga Prasad Ravuri ++ -6o.Aq .fa-.1

I t6092 Durga Lakshmi. S u-3 G..*ll-tiroe
l0 16093 Ganesh Kanipakam renugari 38 \hirtq g'aR
ll 16094 Geetha Theertham L1- -s*d, -{-
t2 16096 Harikrishna Pigilam 3l 'Tllfrfu eo.Pn
l3 16097 Hemanth Kumar Bodireddy 36 -rhrd \td
t4 16099 I laya Raj a Erasappagari +o .Ru-*t t orrrV

l5 l 6100 Jaya Krishna.K u2-- -6\${ *-.ls\
t6 16101 Jayavardhan.N 0-3 S*+, {e..,.
l7 16102 Jyotheeswar Kavali 0-5' -(..^.4.r .&ve

l8 l 6104 Karthik Saadhu 4-l -6.t t{ One

l9 16105 Kesarulu Pulikinti tL6 =0ro*hq Sir<
20 16t 06 Kiran Kumar Nannuru 41y {u,,(q lo.r,
21 16108 Kumar.N.D +f -G'*"*{, -S,e
22 16109 Lalitha Bathula +e- 3**+./ -L*
23 161 l0 Lavanya Narayanamangalam +o 4..'',( m\Y

24 r61ll Lokesh Chilamathuru /+9- -Gtrtv {.co
25 16113 Madhu Pillanagrovi +3 $t'rV -lt'rce
26 161 l4 Mahendra Karra 3q -6i(Er nr

^e
27 t6l l5 Mahesh Babu Orus 36 rhirlq s;x
28 16117 Manandaiah Cheekolu ao drJ

-kv ot+.tl

29 161t8 Mohan Krishna Cherakala /t2- *6..r{q+.m,
30 l6l l9 Nagesh Vatambeti 38 -nir*r-^!ah{
31 t6120 Naresh Gudla Zq 'Thir*9 n\ne
32 t6t21 Naveen Bojja +\ S,...t r *o
33 Naveen Bandla ++ -(-"-r{, -fowt6122



SGS ARTS COLLEGE, TTD, TIRUPATI
DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN ''TALLY''
MARKS SHEET BATCH 3

S.No Rotl No Name of the Student Marks in Figure Marks in Words

I 16161 Anand.M +3 fn^.k -$.rpe
2 16162 Cheekatipalli f',"(,

16163 +2-- .A-*i-r."J
4 16165 Bhargavi.P 4-z -A*"(r+t'.ne
) Bhaskar.T /t-o Jo.,.\q ry\rl
6 I 6168 Charan Raj Kodi +2- -€^.td "uo
7 16170 Dileep Kumar Bandi +o 4.- r{tr on\V

8 Dinesh Samanthavada +l '€.,-v{rl or€
o 16t72 Podavula 3q -nrAr' flioe
l0 16174 Ganesh Kuncham 3B J

-I["',.{.r eiqh+
11 16175 Gavathri Gaddam /t-o f,^-t ,]ru
t2 Gurrappa Nachu 3 1 'i.lr\rt.., t.,'r.r''

l6l 78 Hari Kumar Duddu 4-2-- -ln,,rtq *.rP
t4 16179 Jagadeesh Kamasani +3 9rr.r*q *(vce
l5 l6l 8l Jyothiswar Tharigonda h-b fo,,,( s,
t6 r6182 Kadiresh Kukati L:1 I^,"1, Couen

t1 Karthikeyan.G /L.2.--..-
J

fixrYl..J f'r.o

l8 l6l 85 Kesava.C 39 -/t,lr*q nine
16187 Kishore Godugunuru 38 ri'"frr e,ql"+

20 Bhootannagari 38' -rr,t-i, i;L{
2t 16191 3q 'ltrr-ttr orinp

22 16192 Madhu Kanagani 4b ia.,rl" oo\v
Z) 16193 Madhukar Naik Mude +2- Fo.-,r {..l {.oo
24 16196 Markonda Chennappa 43 Gc",.rtq ttrree
25 16197 Sambaiahpalem 4u- f,..,,iu .1,*,,

26 16199 Nagarjuna Palaparthi ILZ-
:7

.6rr,lr -+,m

27 16201 Prasanth Gurram d-o f*"{, -rv
28 16203 Priya Nagamoodu LO

I

-bu*tq mtt,
29 16204 Purushotham Nellori / I la&,A,i one

30 16213 Sugnanam Harijana lL2- 4""+" t -
31 16214 Sumanth Annameti ,l q- -f.rr,d 4ut
t)a 16215 Sumanth Mudra +o on{v
33 16218 Vasu Siripireddy 42-

44
J Anil Kumar.E

16166

16t7 t

16177

l3

16184

l9

16188

Madasi Hindu



Name of the Student Marks in Figure Marks in WordsRoll NoS.No

34 t6220
Yaswanth Kumar
Yallankila 38 .-rfirrt'r eh{

35 16221 Ashok Manam sk3 'l hiY+{/ .qfl(
36 16222 Balakrishna Ballem .3q r".€I'T1., ..t-i al
37 Bhanu Prakash.B (o 4urtq
38 16226 Govindarajulu.R 3k .rl.'t {, elqhf
39 16227 Guna Sekhar.G.C 3.R" --rfiirtf ft--;ht

40 16228

Harikrishna Reddy
Korlakunta +o four\ 661,

.+l G,r, h., +,,!n
I

Hemadri.G +2-
A1 16234 Mohan Reddy Nalipireddy fouvtv on\V+o
+) 16235 Pavan Kalyan.G 38 'iLi'fu eiqh*
44 16237 Sanjay Goduguchintha 31 " r Lirkr qrvrn
45 1,6240 Sathish Naik Vadthiya 3& .rt.l',( c:cthl
46 16241 Sunil Kumar Madduru ao forr{,r a.,lV
47 16242 Suresh Maddeboyena 1+->- r*^.1+, rth
48 16243 Suresh Pandluru Z 6 -rhh.lu -\ix
49 t6244 j1.., J, -,rvVamsi Krishna Paftukota 4-o
50 Veera Badrudu Gul.vala 4-/ ^JLn, tl,t '1, oO ,

rrEAL, merif
;v{O

lTSl:."T,l

16223

16229

16245



S G S ARTS COLLEGE, TIRUPATI

DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY

Academic year: 2018-19

REPORT OF THE COURSE:

1. Name of the Course

2. Name of the Course Coordinator

3. No of Students Admitted

4. Faculty Members

7. Percentage of Results

8. Date of Theory Examination

9. Name of the Examiner

10. Date of Declaration of Results

: Tally

: Dr. Y.Mallikarjuna Rao

: 150 (50 per batch)

:03

5. Number of Students Appeared for Exam : BatchI:50

Batch II: 50

Batch III: 50

6. Number of Students Passed Batch I : 50

Batch II: 50

Batch III: 50

r00%

28-08-2018

Dr.A.Seshadri, Dr.M.RaviPrasad

l0-09-2018

H;AU
{rcpa rlnlet rt o, tlommclc!
t.G,S. Arr s Collegc iT.LD

fleUPATr-1.- 50{

Signature of urs Coordinator

Dv ' )' AALrlk /J RA0AP fO
rt i. A. t,

(rOPartrna/ :l (,t L)')rnlrrof'-!
ri.G,!'. A.! | c.rrll.+gc;raD

t:'?llFiA!'-' - rrn'

S.NO Name of the Teacher Batch

No of Hours (Classes) Engaged

Theory Practica['s

I Dr. G.Manjula 20 20

2 Dr. T.L Narasimha Reddv II 20 20

J Dr. P.Madhusudhana Rao III 20 20

I



S G S ARTS COLLEGE, TIRUPATI

DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY

Academic year: 2018-19

List of Students Completing the Course

Batch I

S.No Name of the Studcnt Class lloll No

I Akhil Syed BCom TM 16001

2 Anusha Nalathoti BCom TM 16002

J Bhanu Prasad Kothipaka BCom TM 16003

1 Chamindeswari Viswanadham BCom TM 16004

5 Dhanamjaya Gundekayala BCom TM 16005

6 Dinesh Kanaparthi BCom TM I6006

7 Gayathri Kavali BCom TM 16007

8 Guru Prasad Ramanaboina BCom TM t6008

9 Kiran Kumar.S BCom TM 16009

l0 Koteswar Aduri BCom'lM I (r0 l0

ll Leela Krishna aturu BCom TM 160ll

t2 Madhu Sudana Gumpu BCom TM 160t2

l3 BCom TM I 6013

Mahesh Chakali BCom TM r6014

l5 Mahesh Konduru BCom'fl\4 16015

l6 Muni Theja deppagari BCom TM 16016

t7 Naga Surendra Chinnakatti BCom'1-M r6017

Nagarjuna hupakula BCom TM 160r8

l9 Naresh Bhuma BCom TM 16019

20 Pavan Kalyan Thoti BCom TM 16020

2t Pradeep Pandeti BCom TM I 6021

22 Prasad Rokkarokula BCom TM 16022

23 Prasanna Kumar Kotika BCom TM r6023

Madhu Madduru

t4

t8



24 Rajasree Sodem BCom TM t6024

25 Ramesh Koneti BCom TM 16025

26 Ramesh ['allapu BCom TM 16026

27 Ramesh Tatipatri BCom TM 16027

28 Revathi Chennampalli BCom TM 16028

29 Sachin.S BCom TM 16029

30 Sekhar Akkupalli BCom TM 16030

3l Shabeena Syed BCom TM 1603 I

32 Sandhya Surakani BCom TM t6032

Siva Kumar Thupili BCom TM 16033

54 Soniya Narayanavanam BCom TM 16034

35 Sravan Kumar Bedapalli BCom TM 1603 5

36 Subramanyam Kattamanchi I6036

Surendra Thati 1603 7

38 Surendra Tupakula BCom TM 1603 8

39 Vamsi Krishna Cherukuri BCom TM 16039

:10 Vasanth Kumar Naik BCom TM 16040

41 Veeresh Mukarangappagari BCorn 'f M 16041

42 Venkatesh Kandappagari BCom TM 160112

+) Venkatesh Katta BCom TM 160,1i

44 Venkatesh Kukka BCom TM 16044

45 Venkatesh Nidiginti BCom TM 16045

46 Venkateswarlu Guggila BCom TM 16016

47 Venkateswarlu Nagam BCom TM 16047

-+8 Vinay Mogilireku BCom TM 16048

49 Vineeth Suddarasi BCom TM 16049

50 Yadhagiri.R BCom TM 16050

D Signature of ord inator
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S G S ARTS COLLEGE, TIRUPATI

DEPARTMENT OF COMMERCE

CERTIFICATE COURSE IN TALLY

Academic year: 2018-19

List of Students Completing the Course

Batch 2

S.No Name of the Student Chss Roll No

I Ayyaswamy Kuruva BCom EM 1608 I

2 Bhanu Prakash Jangam BCom EM r6082

3 Bheema Shekhar Talari BCom EM 16083

4 Chandini Ayanuru BCom EM 16085

5 Chakrapan i Minuku BCom EM 16086

6 Deva Varshini.S BCorn EM 16088

7 Devendra Kamasani BCom EM r6089

Dhurga Prasad Ravuri BCom EM

9 Durga Lakshmi.S BCom EM 16092

l0 Ganesh Kanipakam renugari BCom EM

ll BCom EM 16094

t2 Harikishna Pigilam BCom EIVI 16096

l3 Hemanth Kumar Bodireddv 16097

I'l Ilaya Raja Erasappagari BCom EM 16099

l5 Java Krishna.K BCorn IIM 16t00

t6 Jayavardhan.N BCorn EN4 l6t0l
t7 Jyotheeswar Kavali BCorn ENI 16t02
IQ Karthik Saadhu BCorn EN'I 16t04

l9 Kesavulu Pulikinti BCom EM 16105

20 Kiran Kumar Nannuru BCom EM 16106

2t BCom EM 16108

Lalitha Bathula BCom EM 16109

23 Lavanya Narayanamangalam BCom EM l6tl0

8 r 6090

16093

Geetha Theertham

BCom EM

Kumar.N.D

22



24 Lokesh Chilamathuru BCom EM l6lll
Madhu Pillanagrovi BCom EM l6l l3

26 Mahendra Karra BCom EM t6l4
27 Mahesh Babu Orus BCom EM l6ll5

Manandaiah Cheekolu BCom EM 16t t7

29 Mohan Krishna Cherakala BCom EM l6lt8
30 Nagesh Vatambeti BCom EN4 l6l l9
3l Naresh Gudla BCom EN{ 16120

32 Naveen Bojja BCom EM l6l2 t

JJ Naveen Bandla BCorn EM t6122

34 Naveen Kathi BCom EM 16t23

35 Naveen Paturu BCom EM 16t24

36 Ninith Kudimi BCorn EN4 16t25

37 Pavan Kalyan Vaidyam BCorr E\I 16126

38 Prabhu-M..1 BCom EM 16127

39 Premkumar Malchi BCom EM 16128

40 Purushotham Bodireddy BCom EM 16t29

4t Raghu Raman BCom EM r6r30

42 Rajesh Gunteti BCom EM l6l3r

43 Reddi Sekhar Reddy.Y BCorn EM 16132

44 Sai Kumar Palamakula BCom EM l6lil
45 Sai Prasad Baddala BCom EN4 16t34

46 Satheesh Chandran BCom EM r6135

47 Satheesh Kalavakunta BCom IIIVI 16136

48 Sathish Kumar.P BCom EM 16t37

49 Siva Peruru BCom EM I 6138

50 Sudheer Mallepalli BCom ENI 16139

Signature of U TSC oord inator
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S G S ARTS COLLEGE, TIRUPATI

DEPARTMENT OF COMMERCB

CERTIFICATE COURSE IN TALLY

Academic year: 2018-19

List of Students Completinq the Course

Batch 3

S.No Name of the Student Class Iloll No

I Anand.M BCom CA l6l6l
2 Ananda Babu Cheekatipalli BCom CA 16162

J Anil Kumar.E BCom CA r6163

Bhargavi.P BCom CA r 6165

5 Bhaskar.T BCom CA 16166

6 Charan Raj Kodi BCom CA r6r68

7 Dileep Kumar Bandi BCom CA 16170

8 Dinesh Samanthavada BCom CA 16171

9 Durga Prasad Yadav Podavula BCom CA 16t72

l0 Ganesh Kuncham BCom CA 16174

ll BCom CA t6t7 5

BCom CA t6177

l3 Hari Kumar Duddu BCom CA 16178

l4 Jagadeesh Kamasani BCom CA t6179

t5 Jyothiswar Tharigonda BCom CA l6l 8l

l6 Kadiresh Kukati BCom CA 16182

17 Karthikeyan.G BCom CA r6t84

l8 Kesava.C BCom CA r6185

l9 Kishore Godugunuru BCom CA l6t87

20 Lakshmipathi Bhootannagari BCom CA 16188

2t Madasi Hindu BCom CA I6l9t
22 Madhu Kanagani BCom CA 16192

z) Madhukar Naik Mude BCom CA 16193

4

Gayathri Gaddam

t2 Gurrappa Nachu



21 Markonda Chennappa BCom CA t6196

25 Muddula Krishna Sambaiahpalem BCom CA 16t97

)A Nagarjuna Palaparthi BCom CA t6199

27 Prasanth Gurram 16201

28 Priya Nagamoodu BConr CA 16203

29 BCom CA t6204

30 Sugnanam Harijana BCom CA 16713

3l Sumanth Annameti BCom CA t62t4

32 Sumanth Mudra 162t5

JJ Vasu Siripireddy BCom CA 16218

34 Yaswanth Kumar Yallankila BCom CA t6220

35 Ashok Manam BA ASCA t622t

36 Balakrishna Ballem BA ASCA 16222

Bhanu Prakash.B BA ASCA 16223

38 Govindarajulu.R BA ASCA t6226

Guna Sekhar.G.C BA ASCA t6227

40 Harikrishna Reddy Korlakunta BA ASCA 16228

4t Hemadri.G BA ASCA 16229

,4'\ Mohan Reddy Nalipireddy 16234

+) Pavan Kalvan.G BA ASCA 16235

44 BA ASCA 16237

4) Sathish Naik Vadthiya BA ASCA 16240

Sunil Kumar Madduru BA ASCA 16241

47 Suresh Maddeboyena 16242

48 Suresh Pandluru 16243

49 Vamsi Krishna Pattukota BA ASCA 16244

Veera Badrudu Guwala 16215

Signature o otl Coordinator
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BCom CA

Purushotham Nellori

BCom CA

39

BA ASCA

Sanjay Goduguchintha

46

BA ASCA

BA ASCA

50 BA ASCA




